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1 OVERVIEW
1.1 Background

The National Ecological Observatory Network’s (NEON) goal is to improve understanding and forecasting
of ecological change at continental scales over decades (Schimel et al. 2011). The design co-locates
measurements of atmosphere, soil, water, select organisms and disease, and airborne observations.
Observing change by integrating measures of the drivers and ecological responses will contribute to
improved understanding of ecological cause and effect (Vitousek 1997, Keller et al. 2008, Luo et al.
2011). High-level requirements derived from the NEON goal and mission guide the architecture of the
design and infrastructure for the national Observatory (Schimel et al. 2011). The primary requirement-
driven constraint of the design is that it must assemble sufficient data collected at points and local
regions (400-km?) to enable extrapolation of these functional relationships to the scale of the continent
over the course of several decades. The requirements framework permeates the NEON design,
providing guidance for the design of observations and direct linkages back to the NEON mission.

A suite of measurements that cross temporal and spatial scales will describe the ecological status and
future trends NEON is designed to detect. Fixed-wing aircraft measure the landscape across NEON sites
with high-resolution remote sensing, and tower-based sensors capture temporally continuous fluxes
over smaller spatial extents. However, neither approach is sufficient for terrestrial biogeochemistry and
organismal observations. A complete census of these measures at each site is biologically and financially
impractical — microbes are ubiquitous and birds are mobile. Measurement of these types of ecological
responses at sensor-like temporal frequencies is impossible, and even frequent observations at local
scales would likely provide redundant information or, due to financial constraints, be limited in spatial
extent. Hence, terrestrial organisms and soil will be measured at discrete temporal and spatial units by
human observers carrying out field-based observations.

The diversity of biogeochemistry and organismal measurements presents a formidable challenge to the
integrated collection of data for the Observatory. Measurements include biodiversity, phenology,
biomass, stoichiometry, prevalence of disease, and genomics of soil and organisms with a range of life
histories and phylogenetic traits (Keller et al. 2008). Components of each will be targeted for
observation with a sample design (Thompson 2012). The design must collect data that capture spatial
variability, facilitate the integration of observations, allow inference to unsampled populations, and
contribute to ecological insight at large spatio-temporal scales. The Spatial Sampling Science Design
(RD[15]) describes the proposed strategy: guided by NEON principles and requirements, the terrestrial
sampling design provides a data collection framework that is statistically rigorous, operationally
efficient, flexible, and readily facilitates integration with other data to advance the understanding of the
drivers of and responses to ecological change. This protocol describes how to implement this design by
creating plots on the ground at NEON sites where the observations that inform the Observatory will be
made.

Page 1 of 117
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1.2 Scope

This document provides a change-controlled version of Observatory protocols and procedures.
Documentation of content changes (i.e. changes in particular tasks or safety practices) will occur via this
change-controlled document, not through field manuals or training materials.

1.2.1 NEON Science Requirements and Data Products

This protocol fulfills Observatory science requirements that reside in NEON’s Dynamic Object-Oriented
Requirements System (DOORS). Copies of approved science requirements have been exported from
DOORS and are available in NEON’s document repository, or upon request.

Execution of this protocol procures samples and/or generates raw data satisfying NEON Observatory
scientific requirements. These data and samples are used to create NEON data products, and are
documented in the NEON Scientific Data Products Catalog (RD[03]).

13 Acknowledgments

This protocol relies heavily on advice and field experience provided by Dr. Benjamin Chemel with the
Northern Rockies Conservation Cooperative.
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2

2.1

RELATED DOCUMENTS AND ACRONYMS

Applicable Documents

Applicable documents contain higher-level information that is implemented in the current document.

Examples include designs, plans, or standards.

AD[01] | NEON.DOC.004300 | EHSS Policy, Program and Management Plan
AD[02] | NEON.DOC.004316 | Operations Field Safety and Security Plan
AD[03] | NEON.DOC.000724 | Domain Chemical Hygiene Plan and Biosafety Manual
AD[04] | NEON.DOC.050005 | Field Operations Job Instruction Training Plan
AD[05] NEON.DOC.004104 NEON Science Performance QA/QC Plan
2.2 Reference Documents

Reference documents contain information that supports or complements the current document.

Examples include related protocols, datasheets, or general-information references.

RD[01] | NEON.DOC.000008 | NEON Acronym List

RD[02] | NEON.DOC.000243 | NEON Glossary of Terms

RD[03] | NEON.DOC.002652 | NEON Level 1, Level 2 and Level 3 Data Products Catalog

RD[04] | NEON.DOC.001271 | NEON Protocol and Procedure: Manual Data Transcription

RD[05] | NEON.DOC.014049 | TOS Protocol and Procedure: Mosquito Sampling

RD[06] | NEON.DOC.014045 | TOS Protocol and Procedure: Tick and Tick-Borne Pathogen Sampling

RD[07] | NEON.DOC.014040 | TOS Protocol and Procedure: Plant Phenology

RD[08] | NEON.DOC.000906 | TOS Science Design for Terrestrial Biogeochemistry

RD[09] | NEON.DOC.000907 | TOS Science Design for Plant Phenology

RD[10] | NEON.DOC.000908 | TOS Science Design for Microbial Diversity

RD[11] | NEON.DOC.000909 | TOS Science Design for Ground Beetle Abundance and Diversity

RD[12] TOS Science Design for Mosquito Abundance, Diversity and
NEON.DOC.000910 | Phenology

RD[13] | NEON.DOC.000911 | TOS Science Design for Vectors and Pathogens

RD[14] | NEON.DOC.000912 | TOS Science Design for Plant Diversity

RD[15] | NEON.DOC.000913 | TOS Science Design for Spatial Sampling

RD[16] | NEON.DOC.000914 :’nC:jSeicience Design for Plant Biomass, Productivity, and Leaf Area

RD[17] | NEON.DOC.000915 | TOS Science Design for Small Mammal Abundance and Diversity

RD[18] | NEON.DOC.000916 | TOS Science Design for Breeding Bird Abundance and Diversity

RD[19] | NEON.DOC.001717 | TOS Standard Operating Procedure: Rangefinder Use and Calibration

RD [20] | NEON.DOC.002649 | NEON Configured Site List

Page 3 of 117
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23 Acronyms
Acronym Definition
HD Horizontal Distance
MDD Main Drop Down (menu icon in GPS receiver)
SDD Sub Drop Down (menu icon in GPS receiver)
NLCD National Land Cover Database
PPE Personal Protective Equipment
GPS Geographic Positioning System
RRQRR Reverse Randomized Quadrant-Recursive Raster
GLONASS Global Navigation Satellite System
OPUS Online Positioning User Service
RINEX Receiver Independent Exchange Format
2.4 Definitions
None given.
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3 METHOD

Plot establishment is an essential step in the development of the NEON Terrestrial Observation System
(TOS). Accurate and precise plot locations that represent the target ecosystem components at each site
will facilitate reproducible data collection and spatial analysis for the life of the Observatory. All plot
locations are created based on a spatially balanced random selection process (RRQRR), and individual
plots are then accepted or rejected based on an assessment by field technicians (RD[15]). The RRQRR
process results in a list of plots, each with a unique identifier called the Morton order. Following the
Morton order list in ascending order (smallest to largest) within each plot type/NLCD class combination
maintains the random selection process during plot establishment. This document outlines the
procedures for location, evaluation, establishment, geospatial data collection and reporting for Tower
Plots, Phenology Transects, Distributed Base Plots, Mammal Grids, Bird Grids, Tick Plots and Mosquito
Point locations.

Tower Plots are located within or around the NEON tower airshed and will be sampled for above and
belowground plant biomass and productivity, plant biodiversity, foliar and wood biogeochemistry, and
soil biogeochemistry. Tower Plots will vary in size between and within sites depending on the dominant
vegetation type and sampling methods. Low biomass, low stature vegetation such as that found in
grasslands and homogeneous low diversity vegetation found in agricultural plots will be monitored in
400 m? square plots, measuring 20 meters on a side. Forested sites require larger plots to accurately
measure plant biomass and productivity than sites dominated by herbaceous plants and shrubs. High
biomass vegetation, found in forest will be measured in 1600m? square plots, 40 meters on a side. Plant
phenology transects are also located within the NEON primary 90% flux tower airshed. Within each site
there will be a subset of tower plots that require a hybrid approach because they contain additional
measurements of biogeochemistry and plant diversity, this subset will be specified and directed by
Science.

Distributed Plots will be located throughout the NEON site. Individual Distributed Plots may be accepted
or rejected based on a field assessment by field technicians; potential plot locations are only accepted if
the actual vegetation type is congruent with the assumed NLCD vegetation type. Prior to plot
establishment, each plot has been subjected to an initial vegetation assessment. All sentinel taxa
sampling will occur at Distributed Plots, although not all taxa will be measured at all Distributed Plots.

The Standard Operating Procedures in this document outlines the specifications for establishing each
taxa-specific sampling plot. Site specific planning documents will identify the location of plots within the
site, specify which taxa will be sampled at each of the identified plot locations and provide lists of
contingency plot locations to replace rejected plots. This Standard Operating Procedure identifies plot
establishment required for all current TOS plot types. The initial establishment includes plot
acceptance, plot delineation, the collection of high resolution coordinates for each marker point, the
assignment of Unique Identifiers and the placement of permanent plot markers with corresponding
identifiers. Annual maintenance of established points may be necessary in the event markers are lost or

Page 5 of 117
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when markers are removed at the end of a sampling season due to site requirements. The annual
marking of sampling points is achieved through the placement of temporary flagging or pin flags that
may be removed following the final round of sampling for the field season.

Several high resolution coordinates will be taken at several locations within each established plot. In
order to attain high accuracy (i.e. to within < 30cm accuracy) at all points within each plot, a procedure
has been developed. This procedure includes a detailed field planning phase, and field techniques that
will assure the acquisition of the highest accuracy points given the tools available. The field planning will
require the use of software (Trimble Pathfinder Office and Trimble Mission Planning packages) and a
detailed GPS receiver accuracy setup. The field work will require attention to detail when following all
procedures and the use of best practices. The post-field protocol constitutes a download of the data
that will be post-processed by Science staff at headquarters (HQ).

3.1 NLCD Vegetation Classification

The NLCD is a continental scale land classification map. It spans the contiguous United States, as well as
Hawaii, Puerto Rico and Alaska. The classification scheme is a two-tiered hierarchy, and our assessment
focuses on the Level Il categories (Error! Reference source not found.). The most commonly used
vegetation types are in bold.

Table 1. The NLCD land use and land cover classification system for use with remote sensing data.

Level | Level Il
11 Open Water
1 Wat
ater 12 Perennial Ice/Snow
21 Developed, Open Space
22 Developed, Low Intensity
2 Developed
evelope 23 Developed, Medium Intensity
24 Developed, High Intensity
3 Barren 31 Barren Land (Rock/Sand/Clay)
41 Deciduous Forest
4 Forest 42 Evergreen Forest
43 Mixed Forest
1 Dwarf *
5 Shrubland 51 Dwarf Scrub

52 Shrub/Scrub

71 Grassland/Herbaceous

72 Sedge/Herbaceous*

73 Lichens*

74 Moss*

81 Pasture/Hay

82 Cultivated Crops

90 Woody Wetlands

95 Emergent Herbaceous Wetlands

7 Herbaceous

8 Planted/Cultivated

9 Wetlands

*Alaska only

Page 6 of 117
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Definitions of each land cover type are available in Anderson’s land use and land cover classification
systems (1976); also at http://www.mrlc.gov/.

Standard Operating Procedures (SOPs), in Section 7 of this document, provide detailed step-by-step
directions, contingency plans, sampling tips, and best practices for implementing this sampling
procedure. The value of NEON data hinges on consistent implementation of this protocol across all
NEON domains, for the life of the project. To properly collect and process samples, field technicians
must follow the protocol and associated SOPs. In the event that local conditions create uncertainty
about carrying out these steps, it is critical that technicians document the problem and enter it in
NEON’s problem tracking system. Use NEON’s problem reporting system to resolve any field issues
associated with implementing this protocol.

Quality assurance will be performed on data collected via these procedures according to the NEON
Science Performance QA/QC Plan (AD[05]).

Quality assurance procedures for plot establishment will be conducted by NEON Domain Field
Operations staff and are an essential step in the establishment process. Correct placement and
documentation of plot markers at each plot enable future field crews to locate and delineate plot
boundaries precisely and identify which type of sampling activities to conduct at each location.

If errors originating in field establishment are detected in a future review, they may be very expensive to
correct and will have a lasting effect on all sampling data associated with plot location. Field audits should
be performed early in the initial field establishment process, to ensure problems are detected and
corrected before an error is propagated across many plots. NEON will use a system of hot and cold checks
similar to that described by the USFS Forest Inventory Analysis (FIA) program. The basic components of
the FIA program are:

e Hot checks: Normally performed as part of the training procedure. Personal observation to
ensure accurate carrying out of protocol by field technicians.

e Cold checks: An inspection done either as part of the training process, or as part of an ongoing
QC program. Technicians are not present, and inspector does have access to field crew
generated data at time of inspection.
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4 SCHEDULE
4.1 Frequency and Timing

Except where placement of permanent plot markers is prohibited by site managers, initial plot
establishment and collection of high resolution geospatial data will occur once per site.

Annual establishment and re-marking of permanent plots for visibility may occur each year of operations
prior to seasonal field sampling.

Plot establishment must occur prior to scheduled taxa sampling.

4.2 Criteria for Determining Establishment Dates

Plot acceptance, delineation and marking should occur prior the start of first year of sampling. Annual
plot establishment activities including re-marking of permanent plots should occur prior to seasonal
field sampling.

4.3 Timing for Laboratory Processing and Analysis

This protocol generates no samples for laboratory analysis.
4.4 Sampling Timing Contingencies

Plot establishment should be completed prior to Operational sampling. Interruptions or delays in the
process—either during a specific plot or all plots—do not impact NEON data products as long as plots
are in place to facilitate the accurate and repeatable observations of Operational sampling.

Reasons to delay sampling have to do with the optimization of establishing a precise, accurate plot with
good geographic record (GPS collection). Reasons to alter the timing of sampling include:

e Precipitation (rain or snow) that interferes with rangefinder

e Dense canopy cover that reduces the satellite reception

e Periods of the day when satellites are less accessible

e Challenges with host site allowing the process to complete, i.e. access issues or other problems
with completing the process

Table 2. Contingent decisions

Delay/Situation Action Outcome for Data Products

Precipitation or . No impact on data products as long as
Stop rangefinding work . . :
snow plots are established prior to sampling
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Insufficient satellite
reception

Spend more time at each point, optimize
time of day, or wait until leaf-off

No impact on data products as long as
plots are established prior to sampling

5 SAFETY

This document identifies procedure-specific safety hazards and associated safety requirements. It does

not describe general safety practices or site-specific safety practices.

Personnel working at a NEON site must be compliant with safe field work practices as outlined in the

Operations Field Safety and Security Plan (AD[02]) and EHSS Policy, Program and Management Plan

(AD[01]). Additional safety issues associated with this field procedure are outlined below. The Field

Operations Manager and the Lead Field Technician have primary authority to stop work activities based

on unsafe field conditions; however, all employees have the responsibility and right to stop their work in

unsafe conditions.

A post driver and/or sledge hammer is used to drive the plot monuments into the ground. Safety

considerations for this equipment include:

e Inspecting and wearing appropriate personal protective equipment (PPE). This may include

impact gloves, hearing protection, and safety glasses.

e Maintaining appropriate posture while driving the monuments, including keeping the back

straight, having a stance square to the monument, and maintaining a safe working height (e.g.

working downhill of the monument and/or kneeling when appropriate).

e Using an appropriate driving technique to maintain control of the equipment, prevents missed

swings, and minimizes the potential for injury.

e Using a Survey Monument Post Driver (30 inches or longer).

A hand or power saw is occasionally used to cut off a portion of the monument rod. Safety

considerations for this equipment include:

e Inspecting and wearing appropriate PPE. This may include cut-resistant gloves, hearing

protection, and safety glasses.

e Operating the equipment with a blade of the appropriate style and in good condition.

e Using an appropriate cutting technique to maintain control of the saw and minimizes the

potential for injury.
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6

6.1

PERSONNEL AND EQUIPMENT

Equipment

The following equipment is needed to implement the procedures in this document. Equipment lists are organized by task. They do not include
standard field and laboratory supplies such as charging stations, first aid kits, drying ovens, ultra-low refrigerators, etc.

Table 3. Equipment list — A crew of two technicians preparing for establishment of one plot

markers

> | — w
E | 8=
Item No. R/S Description Purpose = b o
=] =3 ©
g - -
Durable items
Loadi PS th il I
MX102549 | R | GPS receiver, decimeter accuracy (e.g. GEO XH 6000, 7x) | -02ding data to GPS that will locate plots and 1 | N
generate spatial locations of plot points
MX100322 R Laser Rangefinder Laying out the plot in proper dimension 1 N
R GPS Pathfinder Office Software NEON Loading data t.o GPS that will locate .pIOtS and 1 N
generate spatial locations of plot points
S Marker cutting equipment Cutting secondary markers 1 N
Consumable items
S Secondary markers (e.g. PVC pipe) Raw material for secondary markers
L
S Additional materials to label markers (e.g. spray paint) abel flags, PVC and/or other secondary 1 N

R/S=Required/Suggested
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Table 4. Equipment list — A crew of two technicians performing field establishment of one plot
_ W
> 8 £
Item No. R/S Description Purpose é o =
© % ©
= I
o
Durable Items
MX102549 R GPS receiver, decimeter accuracy (GEO XH 6000, Locate plqts and generate spatial locations 1 N
7000) of plot points
R Extra battery for GPS receiver Extend field GPS collection time 1 N
MX105014 R Range Pole Bracket Secure range pole to GPS 1 N
MX105015 R Range pole with bi-pod attachment Hold antenna 1 N
MX105009 R Antenna Receive satellite information 1 N
MX105012 R Antenna Cable Connect antenna to GPS 1 N
MX100322 R Laser Rangefinder, % foot accuracy Lay out the plot in proper dimension 1 N
R Extra batteries for Laser Rangefinder Extend field time of rangefinder N
R Lens cleaning cloth Cleaning rangefinder lens 1 N
R Reflective tape or bicycle reflector Sight rangefinder 2 N
MX100320 R Compass with mirror and declination adjustment Sight angles for laying out the plot 2 N
MX100722 R Measuring tapes 230 m Measure distances for laying out the plot 2 N
MX104361 R Chaining pins or other suitable anchor Anchor measuring tapes 5 N
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R Maps Navigation to plot N
R Log Sheets (See Appendix A) Record information/notes 1 N
R Definitions of Land Use and Land Cover Classification Field-based validation 1 N
R FOPs datasheet with a list of potential plots Reference 1 N
S GPS rgcelver, recreational accuracy with fully charged Navigation 1 N
batteries

R GPS Pathfinder Office Software Transfer and inspect spatial data 1 N
S Anchor Plot delineation 1 N
S PVC pipe cutter Cutting secondary markers 1 N

MX110476 R Survey Monument Post Driver (30 inches or longer) Install primary markers N
R Survey Monument Driving Pin Adapter Install primary markers N

MX110497 Impact gloves

(Medium)
MX110498
(Large) R Protect Hands from the potential force of 1 pair per N

MX110499 the driver striking the post. staff

(Extra Large)

MX110500

(Small)
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_
> e £
Item No. R/S Description Purpose § b =
© ;% ©
= I
o
Mx104257 Protect ears and hearing from loud noises .
or R Ear Plugs while driving monument rods into the 1 pair per N
MX102814 & o & staff
(latex free) &
MX104378 R Sledge hammer Driving monument rods 1 N
MX107089 R 4.5”x0.75” stainless steel driving adapter Driving monument rods 1 N
<& R Hand or power saw Removal of excess rod 1 N
MX101703 P
©-6- R Pliers Tightening sections 1 N
MX101535 & &
MX109524 S Crow or pry bar Removal of temporary plot marker 1 N
Consumable Items
) . . . Max 20
R Pin Flags, PVC posts or other temporary markers! Used during plot delineation aXpIot per N
R Secondary Markers (e.g. PVC, Survey stakes)? Marking plot corners variable N
MX107388 R 2.5” flat survey cap, stamped Monument component variable N
MX106864 R 1’x0.75” aluminum monument rod sections Monument component variable N
MX106865 R 3’x0.75” aluminum monument rod sections Monument component variable N
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markers

MX106994 R 3’x0.75” aluminum monument rod sections Monument component variable
MX106863 R 6”x0.75” aluminum driving rod section Monument component variable
e.g.
MX101705 Metal blades for hand or power saw Removal of excess rod 1

R Paper plate Catchment for saw debris 1

S Additional materials to label markers (e.g. spray paint) Label flags, PVC and/or other secondary 2

markers
S Pencils Record information/notes 3
S Additional materials to label markers (e.g. spray paint) Label flags, PVC and/or other secondary 1

R/S=Required/Suggested

1 Secondary and temporary marker quantities will vary depending on plot type and site-specific plot monumentation strategies, which will be dependent upon local conditions and

site host restrictions.
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6.2 Training Requirements

All technicians must complete required safety training and protocol-specific training for safety and
implementation of this protocol as required in the Field Operations Job Instruction Training Plan
(AD[04]).

All field technicians must have hands-on training with the GPS receiver with TerraSync software,
antennae, laser rangefinder and handheld compass with sighting mirror and declination prior to
conducting field work. At least two technicians in each domain shall be trained and proficient in the use
of GPS Pathfinder Office software and mission planning.

6.3 Specialized Skills

A team of two field technicians is required for plot establishment (delineation, marking and spatial data
collection). Training will be provided for all specialized skills required for carrying out plot establishment
(i.e. equipment use). Technicians are not required to have any additional skills other than those
specified in the NEON Field Technician job description. Proficiency with compass and GPS receiver is
useful and should be part of training to prepare to go into the field for this protocol.

6.4 Estimated Time

The time required to implement a protocol will vary greatly depending on a number of factors, such as
skill level, system diversity, environmental conditions, and distance between sample plots. The
timeframe provided below is an estimate based on completion of a task by a skilled two-person team
(i.e., not the time it takes at the beginning of the field season). Use this estimate as framework for
assessing progress. If a task is taking significantly longer than the estimated time, a problem ticket
should be submitted.

A two person team will require approximately four hours to establish one distributed base plot. Plot
establishment includes metadata collection, plot delineation, marking, and spatial data collection.
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7 STANDARD OPERATING PROCEDURES FOR TOS PLOTS

Legend

wiy

\. Tower, soil array

Prevailing wind

Distributed Base
plot

Gradient Base plot

Tower Base plot

Tower Phenology

Mammal grid
Bird grid

NLCD veg type A
(dominant)

NLCD veg type B

Veg type C

esC eEDNOHE®

Veg type D

Figure 1. Generalized site-scale sampling schematic for the NEON Terrestrial Observation System (TOS)
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7.1 Workflow of Plot Establishment Activities

Compile all Equipment and Materials soPA

v

Navigate to preloaded point sors

Complete NLCD canopy cover assessment

Does the vegetation at the plot match the expected
vegetation class? sopB Complete logistical validation.

NO

YES

N

Create a New Data File
Reject plot location, note the reason,

choose next plot from RRQRR list. sor B

Create a New Data File

Record metadata in data dictionary
sorPB

Distributed

Perform Distributed plot Delineation
and Monumentation for :

Base, Small Mammals, Birds or Ticks.
sorcC

Is the plot a tower or distributed plot?

.

Tower

)\

Perform Tower plot Delineation
and Monumentation for :

Plant Productivity or Phenology.
sopc

Conduct GPS Coordinate Collection.
SoPD

|

Check for co-located plots. Pull flags and
tape, navigate to next preloaded
potential plot origin.

At the end of day complete SOP E to
transfer data
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SOP A

Preparing for Establishment

Follow Error! Reference source not found.-8 to complete preparation for plot establishment.

A.l Resources

During training you will be provided with a NEON network drive path. This drive will serve as a

communication gateway between Science and FOPS; it will also serve as a source of materials for data

collection. The corresponding drive will include the following materials:

Table 5. Materials provided for use of FOPs and Science. These folders are located in the designated drive; the specific
organization of these folders is not outlined in this table.

used by FOPS for collection.

Folder Content Format Purpose
Contains all GPS data files (plot Data files to be used by
GPS_Pathfinder_Files locations, roads, boundary and others) .imp FOPS staff to collect plot

data.

PlotID.

Maps .pdf Maps to be used by FOPS.
o . Layers to be used in
Plot layout and site information .kmz google earth by FOPS
XX_XXXX_TOS_Plots_Datasheet: Datasheet to be used by
Site_Information_& _Datasheets | Contains all Distributed plots, Morton wlsx Science and FOPS, must
Order, vegetation type, plot status and ’ be regularly updated by
coordinates. FOPS.
Contains site information and notes . .
. . . Background information
from previous remote and field (if .docx .
. N about the site for FOPs
applicable) validation
This datasheet contains
XX_XXXX_Unique_ldentifiers: all PlotIDs used to label
Established Contains plot type, Morton Order and Xlsx TOS plots. Datasheet

created by Science and
used by FOPS.
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Folder Content Format Purpose
Unique Identifiers should
be provided by Science
XX_XXXX_Validation_Information: .docx after plots are
established, to be used
for plot marker labels.
Contains all data dictionaries. A Data
dictionary is a digital form used to log To be used by FOPS to
Data_Dictionaries metadata about each plot. Data .ddf collect ALL plot

receiver.

Dictionaries are uploaded to the GPS

establishment data.

Log_Sheets

collection.

Contains log sheets used to maintain a
record of markers and GPS data
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A.2 GPS Receiver Setup

The following are the general steps to follow in order to complete the GPS setup. To complete
this section please follow the detailed steps for the relevant GPS model and software version in

Error! Reference source not found..

1. Turn GPS receiver on.
Initialize GPS software (e.g. Terra Sync).

Once the GPS software is initiated, the first day of work at a site, make sure to adjust the GPS

time, specifically the GPS unit Time Zone, Date and Time.

4. Complete setup menu specifics.
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A3 Global Navigation Satellite System (GNSS) Planning Online software

The GNSS Planning online software tool will help you understand satellite availability (number of
satellites) before heading out to the field. If the site at hand has little satellite cover (fewer than six
satellites at a time), it is important to find the windows of time with higher satellite availability. Use
these windows of time to collect high-accuracy data. If the site has a constant flow of six or more
satellites at a time, then the time of collection is less important. To find out satellite availability and to
plan your field days -as needed-, use the following steps:

1. Visit http://www.trimble.com/GNSSPlanningOnline/#/Settings
2. Click on the Setting tab located in the upper left side of the window.

a. To assess the relative satellite availability across a site, add the latitude and longitude of the
tower location (RD[20]).

To assess satellite availability of a particular plot location of concern, add the latitude and
longitude of the specific plot. You can find the plot location in the datasheets provided by
Science. This may be useful if a technician knows of a potential satellite obstruction located
close to a plot (e.g. boulder) previous to field work.

b. Height:0m
c. Cutoff: change it to 0°—however, this field can be changed if obstructions are known at a
particular plot. For this the latitude and longitude must be related to a particular plot.
Select the field Day
Select the starting time or Visible Interval and the time span in hours (generally a 6- or 12-
hour span).
f. Select the appropriate Time Zone.
g. Click Apply.
3. Tothe left of the screen click on the Satellite Library
a. Click on the GPS and the GLONASS satellite libraries; unclick the rest of the satellite libraries.
4. To the left of the screen click on the Number of Satellites.

This histogram will display the number of satellites (GPS and GLONASS) available on the Y axis, and time
on the x axis, including what the GPS would measure with any obstructions previously plugged in the
Settings (if any). The higher the number of satellites available the better the accuracy will be. This graph
will allow field workers to know when the best times to establish challenging plots may or may not be.

In your notes, record what times have the highest number of satellites (highest accuracy) and what
times have the lowest number of satellites (lower accuracy) to collect GPS data. Avoid accruing data in
the times when there are fewer than four satellites available; otherwise the data will be of low accuracy.

Page 21 of 117



http://www.trimble.com/GNSSPlanningOnline/#/Settings

Date: 03/20/2017

n e ;.) n Title: TOS Protocol and Procedure: Plot Establishment

NEON Doc. #: NEON.DOC.001025 | Author: E. Azuaje

National Ecological Observatory Network

Revision: F

A4 Transfer data to GPS

1. Connecting the GPS unit to the computer:

To complete this step, follow the directions in pages 30-33 in the Terra Sync “Getting Started
Guide” (Trimble, 30-33). This guide is available in the NEON network drive folder described in

SOP Error! Reference source not found..

2. Types of files to transfer for a typical fieldwork campaign:

The data files to transfer for a typical fieldwork campaign will be located in a shared folder
(Error! Reference source not found. in folder ‘GPS_Pathfinder_Files’). These files will be in .imp
format (these are Trimble imported files that can be read by both Pathfinder Office and the GPS
unit). There are three types of files that will be transferred from Pathfinder Office to the GPS

unit:

a. Background files include roads, lakes, streams, buildings, contours and others. These files
are located in folder GPS_Pathfinder_Files, see Error! Reference source not found..

b. Data files includes points converted from ArcGIS shape files. These are the points that will
be followed and have been previously assessed for plot establishment. These files are

located in folder GPS_Pathfinder_Files, see Error! Reference source not found..

c. GPS Data dictionary contains pre-defined attributes and metadata that can be associated
with newly logged GPS data. The GPS data dictionary will be completed for every point
collected. These files are located in folder Data_Dictionaries, see Error! Reference source

not found..
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A5

1.

Loading and checking files in GPS with Pathfinder Office

Open Pathfinder

Office software

2. Create a project for each site. Set up the Default folders in the shared folders provided

Default folder for
Project Folder:
Backup files:

Export files:
Base files:

[V Display this dizlog at start-up

— —_—
Select Project — B — ==
Project Name: |TREE j oK
Comment: Thursday, January 22, 2015 3:20:37 pm Help

A:\FOPS\05_Grlakes'\Rel TREE\GPS Pathfinder_Files

A:\FOPS\05_GrLakes'Rel_TREE\GPS_Pathfinder_Files\Backup
A:\FOPS\05_GrLakes'\Rel_TREE\GPS_Pathfinder_Files\Export
A:\FOPS\05_GrLakes'\Rel_TREE\GPS_Pathfinder_Files\Base

New... Remove | Modify... |

Figure 2. Pathfinder Office project

3. Go to Options and select Coordinate System

O N w

10.

a.

® oo T

datum

Click OK

Select by: click on Coordinate System and Zone select the appropriate system, zone and

Altitude Measured From: select Mean Sea Level (MSL)
Coordinate units: Meters
Altitude Units: Meters

In the main screen, select File > Background... and in the “Load Background Files” window, click
“Add...” and select the file(s) desired as background images (e.g. boundary, roads, streams).
Check the box next to the desired image(s).

Click OK to load the background files into the Map.

Click View > Map to visually check the images that will be loaded to the GPS.

To check datafiles open the imp, .ssf, .cor, or .imp file in pathfinder by selecting File>Open or
dragging the file into the map

In the main scree

n select Data>Feature Properties and select Data>Position Properties

Click on the X’s in the map view (the individual points) to load the point information in the
Feature Properties and Position Properties boxes.

a.

For example, you can view the date, number of logs, estimated accuracy, and point feature

name of a point in an .ssf, .cor, .imp file.
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A.6

Transfer data files, GPS data dictionary, and background image(s) to the GPS unit

1. Onthe GPS, connect the GPS to the computer with the supplied USB cable, and power on the
unit. Tap on the Windows icon at the bottom left side of the GPS screen.

2. Find the TerraSync icon and tap twice with the stylus.
On the computer, use the Windows Mobile Device Center (Win7 or Vista) to connect the device
to Windows. If this is the first time connecting the GPS to the computer the Windows Mobile

Device Center may install automatically, if it doesn’t, download it online from the windows

software website.

Set the coordinate system in the Trimble TerraSync software to the corresponding coordinate

system used for the site:

a.

C.

In the TerraSync software on the GPS, from the MDD tap Setup then click the “Coordinate
System” box.

Match to the coordinate system of downloaded data, select: System = UTM, Zone =
appropriate zone, and Datum then click OK (RD [20]).

From the MDD, return to the Map screen.

5. Once the GPS unit is connected to the computer, within Pathfinder Office, use the Data
Transfer utility to transfer all the files (background, data dictionary and data files) to the
Trimble:

a.

b.

d.
In the TerraSync software on the GPS, select the transferred image(s) as the background:

6.

7.

Go to Utilities > Data Transfer... and in the window that comes up, click the Send tab and
click Add... and select Background from the list. Select background files (e.g. boundary,
roads, streams and others) and click OK.

Then click Add and select Data Dictionary, browse for the appropriate GPS data dictionary
location in the shared drive, select all applicable data dictionaries and click Open.

Once more, click Add and select Data File, browse for the point files for all of the plot
locations, and click Open.

After selecting all file types to transfer to the GPS click Transfer All.

Use MDD and tap on Map. From this pane go to the Layers SDD and click Background Files...
In the list of files, select which image file(s) you would like to use as background and click
OK.

To temporarily turn off the background image (can be used to reduce software wait time
while making measurements) go to the Layers SDD and un-check Background.

When transfer is complete, disconnect the unit and follow model instructions.

8. Make sure the GPS is fully charged before heading to the field.
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A.7 Configure the rangefinder

Refer to RD[19] for details.

A.8 Site Specific Plot Information

An excel sheet will be provided for each site by science staff in a shared folder (Table 5 in folder
“Site_Information_&_Datasheet”). The sheet contains information regarding the morton order list, plot
type, plot size, plot location, number of target plots per NLCD vegetation type, and spaces for field
technicians to update progress. The sheet will be the main point of contact between FOPs and Science
during plot establishment. PDF maps and kmz files for google earth will be provided as well.
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SOP B

Plot Acceptance

At the start of the field day, remember to:

4]
4]

M

Turn on the unit in an open area for at least 5 min before entering a closed canopy system.
On a daily basis, verify that the GPS almanac has been updated within the last week or anytime
the unit is moved to a new NEON site. To update the almanac it is necessary to have at least one
satellite locked and it should take at most 15 minutes. To check when the almanac was last
updated go to MDD>Status and SDD>Receiver>Almanac

o To force an almanac update go to MDD>Setup and SDD>Options>Reset GNSS Receiver
Once the GPS has been turned on, take care to always keep the antenna relatively flat, even
when not collecting data. This will ensure that a minimum number of satellites are dropped.
Do not stand in front of or otherwise block GPS unit. Make sure the barometric pressure holes
on the under-side of the Trimble are not obstructed.
While hiking or collecting data, make sure the sleep function is disabled, every time the unit
goes into sleep mode satellites will be lost. To disable the sleep function:

o Press the green button for 3 seconds. This button is located below the screen

o Click on Power Settings

o Uncheck the box below On battery power

o Click OK
Always take an extra fully charged GPS battery.
Create a Waypoint for the location of the vehicle:
Click on MDD > Navigation
On the SDD > Waypoints
Click on New at the lower left side of the screen.
Location Default
Name waypoint at File Name
Click Done
Click on Options on the upper right, and then click on New.
Name the waypoint (i.e. RMNP_Car_06162011)
Click on Create Form on the upper right, and then click on GNSS. The coordinates should

W N R WDNPR

load.

10. Click Done. Waypoint should be created.

11. To close the created file, go to Options and click on Close File.

12. Go back to MDD > Navigation. Make sure the SDD is on Waypoint and then Click OK. The
waypoint should be created.

13. When returning to the car, click on MDD > Navigation and SDD > Waypoints. Highlight the
file of interest and click Open on the lower right side of the screen.
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B.1

14. Click on the box to active and tap for one second on the waypoint files. Click on Set Nav

Target

15. Go back to SDD> Navigate and when moving it will point you to the navigation target.

Navigate to pre-loaded GPS point

Preloaded GPS points will be classified by plot type (See Method section for a list of plot types). Before
leaving the car create a waypoint of the car location or starting location AND write down the

coordinates and elevation of the car in a field notebook, this is a safety practice to ensure technicians

have coordinates to navigate back to the vehicle.

1.

Open the data file associated with the current site:

Go to MDD > Data, and then go to the SDD > Existing File. You should see a list of data files
loaded onto the Trimble.
Select the data file associated with the current site, and click Open.

e Make sure that the Antenna Height is at 1 m, and the Type refers to the GPS internal
model . Keep the setting on “measure to bottom of receiver”; then click OK on “confirm
antenna height” pop-up.

Go to MDD > Map to see the plots loaded on the map. Go back to MDD > Data

Find the Plot Morton Order of the targeted plot. Tap and press (1-2 seconds) on the Morton
Order number. A pop-up menu should appear. Select Set Nav Target. Note: the targeted
plot should now have a flagged symbol.

Or

To set a plot as a navigation target from the MDD > Map, choose the Select tool ( ) from
the left-most SDD, and hold the stylus on the plot until a box pops up that says “Delete” and
“Set Target.” Choose “Set Target.”

To check the Morton order of a plot from the Map pane, tap on the select tool from the left-
most SDD menu. Tapping a plot icon quickly with the stylus will bring up the name and
coordinates of that particular plot.

2. Tozoom in, while in the MDD>Map, go to the leftmost SDD menu and select the zoom-in tool.

Zoom in by dragging the stylus along a diagonal that encompasses the desired area.

3. Go to MDD > Navigation and make sure the left SDD says Navigate.

For some Trimble models with no internal compass, the Navigate window won’t make any
sense until you are moving. If navigating over longer distances it is often easier to take the
bearing from the GPS unit and then navigate with a regular compass until you within ~20m
of the point.
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B.2

e. When close to the target position the location of the GPS is displayed as an “X” and the
target as an “O”. You will need to move around until you are as close as possible to the
desired location (“O”). Make sure you are within 3 meters from the desired location. If you
are having trouble obtaining the desired location within 3 meters, attach the antenna
following the instructions in SOP D.

f.  When you have arrived at a targeted point, go to MDD > Map, and select Options > Clear
Nav Targets. Go to MDD > Data and click on Done and then on Close button to exit the
points data file. A window will pop up asking: Close this file. Are you sure? Click on Yes.

If the unit goes into sleep mode, push the power button again to wake the unit and resume
data collection. Make sure to wait until satellites are re-acquired. A warning will pop up;

click Dismiss. If the GPS unit is not collecting satellites, go to MDD > Setup and click the GPS

button again to reconnect the GPS receiver. Then return to the Map screen and resume
data collection.

Canopy cover assessment

Canopy cover assessment will be based on the National Land Cover Database (NLCD) classification
(Appendix E) for all Distributed Plots. Plot locations are only accepted if the actual vegetation type is
congruent with the assumed NLCD vegetation type. The XX _XXXX_TOS_Plots_Datasheets provided by
Science lists the NLCD land cover type in the “nlcdClass” column (see Table 5Error! Reference source
not found.).

1. Once within the plot, determine location of plot perimeter, you can run a tape across four

cardinal directions (or use the range finder and reflector) and set up visual cues (it could be
flagging tape, a rock, a tree etc.) that would indicate the perimeter of the plot.
a. Since Bird and Mammal Grids are so large and it is difficult to determine land cover type
percentages err on the side of NLCD unless the classification is obviously off.
b. For Mosquito Points validate an area 40m by 40m with the point location as the centroid.

2. Determine plot Level 1 classification (e.g. Forest, Shrubland). Located in NLCD classification

description ( see Error! Reference source not found.).
a. Remember- NLCD defines the dominant vegetation stratum by height (i.e. the tallest
vegetation is “dominant”) since NLCD assesses canopy from satellite imagery.

3. Within each Level 1 NLCD class, determine Level 2. For example, if the Level 1 classification is

Forest, the next step is to determine if it is a Deciduous, Evergreen, or Mixed Forest.

IMPORTANT: Level 1 classification determines the total percent cover for the plot (e.g. 40% of

the plot is forest); Level 2 is then assessed out of 100% of the Level 1 total (e.g. of the 40% of the

plots that is forest, 50% of that forest area is deciduous, 50% of that forest area is evergreen,
NOT 20% deciduous forest and 20% evergreen forest).
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4. Evaluate the results of the Level 1 and Level 2 classification to determine whether the plot

should be accepted or rejected.

In instances where the plot classification (either Level 1 or Level 2) is unclear due to borderline

percent cover(s) (i.e. near the % cover cut-off described in E), acceptance or rejection should be

based on group consensus. If disagreement persists, the plot should be rejected. For example,

when validating a deciduous forest plot (Level 2) where more than 75% of the total forest cover

in the plot should be deciduous to be accepted, if the sampling crew cannot agree because
person 1 thinks plot deciduous forest cover is below the 75% threshold and person 2 thinks the

plot is above this threshold, then the plot should be rejected.

If level 1 classification is rejected, please assess both Level 1 and Level 2 classifications and record

to the corresponding rejected plot metadata.

5. Begin metadata collection with the Trimble, regardless of the results of the above assessment,

as described in SOP sections B.3 through B.7.

a. If plotis accepted based on above assessment, place a temporary marker (anchor, flag, etc.)

in the center of the plot.
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B.3 Trimble Data File Naming Conventions

Files must be named according to the following convention:

Filename begins with the letter D, followed by the two digit number for the domain, followed by an

underscore: e.g. DO1_

1. Add the four letter site ID followed by an underscore: e.g. DO1_HARV_
2. Add the value denoting Morton Order plot number followed by an underscore: e.g.

DO1_HARV_1_, DO1_HARV_1234020_
3. Add a letter to indicate the plot type followed by an underscore: e.g. DO1_HARV_1_T_. Plot
type letters are:

e “T”toindicate a “Tower” Plot.

e “H” to indicate a “PHenology” Plot.

e “R” toindicate a “DistRibuted Base” Plot.
e “K” toindicate a “TicK” Plot.

e “M” toindicate a “Mammal” Grid.

e “B” toindicate a “Bird” Grid.

e “Q” toindicate a “MosQuito” Point.

4. |If the plot is accepted the letters “GPS” are added to indicate file contains GPS data: e.g.
DO1_HARV_1_T_GPS

Each time a plot is visited to collect GPS points a new file must be created. Follow the same naming
convention outlined above and add V # to the end of the file name. E.g. DO1_BART_199 R_GPS V4 ifit
is your fourth time collecting GPS points at a plot.
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B.4

Metadata collection

Metadata collected with the GPS includes information about plot acceptance, vegetation type,
and other plot characteristics. Use the appropriate GPS data dictionary and plot ID labeling
(Section B.3). Metadata only needs to be collected once per plot.

To collect metadata use the following instructions:

a. Make sure the file used to hike to the plot has been Closed; if it hasn’t, go to the
MDD > Data and click Done.

b. When establishing plots, create a new data file for each unique plot. Go to MDD > Data, and
then go to the SDD menu and select New (T).

c. Keep the settings on File type (Rover) and Location (Default); Click on the File Name field
and choose an appropriate name. Refer to the ‘Data File Naming Guidelines’ (SOP Error!
Reference source not found.) of this protocol for naming convention.

d. In Dictionary Name choose the GPS data dictionary that is appropriate for the given plot
(Distributed Base Plot, Tower Base Plot, Mammal Grid, etc) and task (soil sampling at 20m
by 20m Tower Base Plots, Plant Diversity sampling at 40m by 40m Tower Base Plots,
etc).Click Create.

e. Change antennae height to 2.000 m

f. Select Type as antenna model 2 and click OK (Do not set up the antenna at this point).

g. Open the appropriate GPS data dictionary based on the plot type you are currently in. Make
sure the receiver is active by going to the MDD>Setup; if the satellite icon is not visible: click
on the GNSS box which should be in upper right side of the screen, if the receiver is NOT
active you will see a satellite icon to the right of the MDD menu. If the receiver is already
active the following message should appear:

Are you sure you want to disconnect from GNSS receiver? Click on NO to
maintain the receiver active

All GPS data dictionaries will contain a set of features; you will need to go through all of
them.

h. Go back to the MDD>Data screen; once the new file is created open the metadata feature.
The following includes all fields across GPS data dictionaries reflected in the metadata
feature. All or a subset of these questions will be in the corresponding GPS data dictionary:

e Date: Click on the drop down menu and choose the corresponding date.
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e Operator Name: click on the blank space below and the keyboard should appear, write
down the initials of the two crew members.

e Morton Order: on the list of plots find the corresponding plot Morton Order number
and record it.

e NLCD Vegetation: click on the drop down menu and select the vegetation subclass
information that has been predetermined by NLCD and vetted by remote sensing
validation specialists.

e Site Vegetation: after a team analysis of the canopy percent cover, determine the
existing vegetation NLCD category

e Percent Cover: NLCD Percent Cover: i.e. 55 deciduous forest 45 evergreen forests.

o Make sure that the sum of the percentages add to 100%. Account for the highest
strata only (i.e. if there is an evergreen, deciduous upper canopy and a shrub
lower canopy, only account for the higher stratum for your percent cover—see
section B.2).

e Plot Accepted: if the NLCD vegetation is the same as your team’s assessment of the site
vegetation then click on YES to accept the plot, otherwise select NO. If rejecting the plot
based on criteria other than NLCD mismatch (see section B.5), also select NO. When No
is selected, several fields will recede from view, at this point click Done and close the
feature.

o Tree Cover: assess % cover based on bird’s eye view, select from the drop down.

e Saplings and shrubs cover: assess % cover based on bird’s eye view, select from the
drop down. For example, if the entire understory of a plot is shrubs but 50% of the plot
is covered by tree cover than the sapling and shrubs cover will be 50%.

e Herbaceous cover: assess % cover based on bird’s eye view, select from the drop
down.

e Slope: standing at the centroid, select the steepest slope to any of the following point
IDs: 49, 50, 51, 40, 42, 31, 32, 33. Use the rangefinder RD[19] to measure the slope
(percent).

e [f the steepest slope point does not have a line of sight, choose the next location
that has a line of sight and is the closest to the steepest slope

e Ifthereisn’t a line of sight to any of the point IDs targeted, find a line of sight that
brings you the closest to any of the previously mentioned point IDs; for example, a
line of sight between the centroid and 5 meters towards point ID 32.

o Slope Azimuth: this is the azimuth of the slope inclination previously made, use
rangefinder, RD[19].

o With Rangefinder still at low end of slope and reflector at the high end, change
measurement mode to AZ.

o Measure azimuth (degrees)
= [f the slope is O the azimuth is not required.
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e Comments: add any pertinent comments, for example ‘plot has several fallen tree
trunks.” If there are potential obstructions that can affect GPS measurements make note

of azimuth and description of obstruction object.

o Photos (camera icon): When prompted use the Trimble to take a photo towards the

plot centroid or for the phenology transect clockwise towards the next point on the

transect. Be sure that photos are clear and portray the landscape only (i.e. no

technicians or backpacks).

i. Click Done to store data. Close the feature but NOT the file. A message should appear: “No
positions recorded. Do you want to store this feature now?” click Yes. If the data file is

accidentally closed follow instructions below.

How to Access an Existing Closed Data File

AW

Go to MDD>Data and SDD>Existing files
Look for the desired existing file

Click on the file

Click Open on the lower left of the screen

Page 33 of 117




n e :.) n Title: TOS Protocol and Procedure: Plot Establishment Date: 03/20/2017

NEON Doc. #: NEON.DOC.001025 | Author: E. Azuaje Revision: F

National Ecological Observatory Network

B.5

Rejected sampling plots

In all cases where a plot is rejected, record the rationale in the corresponding pre-loaded Data

Dictionary. Do not record spatial location for rejected plots. After recording metadata, move on to the

next plot location in sequence based on the Morton Order plot list. If the rejection of plots is so high

that it is not possible to establish the desired number of plots at a given site, contact Science to provide

additional plot locations.

A selected plot may be rejected by the field crew if:

Plot location is in a creek (wider than 10m), is too wet (see Appendix C), or presents other
geographical features that prevent sampling as specified in the associated TOS protocol(s).

The Distributed Plot conditions do not match the NLCD vegetation classification. Note that NLCD
vegetation does not apply to Tower Plots or Phenology Plots.

Field conditions are deemed unsafe by the field crew.

Logistical reasons as determined by Field Operations staff; make sure the reasoning is outlined
in the comments field of the plot’s metadata.

Tick plots may be rejected if more than 50% the plot perimeter (i.e., 80m of the 160m
perimeter) is not amenable for tick sampling using the dragging or flagging method(s) (or both).
For example, sections of the perimeter that run through dense patches of briars likely cannot be
sampled by either method.

If a 4m offset is not enough to negotiate around an obstacle at the centroid of a base plot. See
section B.7 for more information on offsets.

To record rejected plots follow these steps:

1.

Make sure the file used to hike to the plot has been Closed; if it hasn’t go to the MDD > Data
and click Done.

Go to MDD > Data, and then go to the SDD menu and select New (T). -Use data naming
conventions (see SOP Error! Reference source not found.) -and add the corresponding data
dictionary,

Click Create.

Keep the settings on File type (Rover) and Location (Default); Click on the File Name field,
choose an appropriate name and data dictionary. e.g. D10_RMNP_1095_R_GPS.

Change antennae height to 1.000 m

Keep Type as the internal antenna option for your model and click OK, this will set the unit for
hiking.

Answer all relevant questions in the GPS metadata feature (see section Error! Reference
source not found., step Error! Reference source not found. in this SOP for metadata fields).
Once metadata are completed, close feature.
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B.6

B.7

10.

Close data file; a message will appear: No positions recorded. Do you want to store this feature
now? Tap on Yes

Close data file; a message will appear: Close this file. Are you sure? Tap Yes.

And select next location following the Morton Order.

Accepted sampling plots

Each plot will be saved under one data file during each visit. Once a file is created and named,
this file will not be closed until all points within the plot are measured (i.e. centroids and all
corner and cardinal points). Alternatively, staff could collect centroids for all plots first and
then during another instance delineate and collect the remaining points in a new file. In this
instance the second .ssf file created will be labeled DXX_Sitecode_MOrder_plot type
letter_GPS_V2.

Determine plot centroid/origin

If a plot centroid/origin falls on a location where it is not feasible to place a permanent marker
(e.g. a rocky outcrop), the field crew may shift the centroid to avoid an obstacle provided that
the direction of the shift is selected to minimize the deviation from the provided point (i.e. the
closest suitable location), within the specifications below.

Maximum distance of shifts by plot type:

e Distributed Base and Tower Base Plots can be shifted < 3 meters (10% of the randomly
generated RRQRR cell).

e Phenology Plots cannot be shifted

e Mammal and Bird Grids can be shifted 50m and 150m respectively but new locations must
be approved by Science staff due to additional buffers.

o Tick Plots can be shifted 15m but new locations must be approved by Science staff due to
additional buffers.

e Mosquito Points can be shifted up to 10m.

Record compass direction, distance of shift, and rationale in the comments section of the data
dictionary.

Shifting and offsetting point locations

Shift: used to describe how much a marker can be moved from the desired point so that it can be placed

in the ground and coordinates collected at that shifted location.

Offset: used to describe placing of a marker at some recorded distance and direction from the desired

point; the high resolution coordinates are collected at the original point, not at the offset. The azimuth
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and direction to the marked offset from the desired point must be recorded in the comment section of
the metadata. Also record this information in a place that will be available to staff when they re-visit the
plot. Offset information should also be written on the marker in the ground.

Centroid points

In the event that a plot centroid must be shifted, record the compass direction (azimuth from True
North) and distance of the shift, and the rationale for the shift in the metadata; then proceed to collect
high resolution GPS point data for the new location. Build out the rest of the plot with the new centroid
as a starting point. If the plot origin is shifted up to 3 meters and a marker still cannot be placed, you
can keep the 3 meter shift and offset the marker up to 4 meters. If the offset is not enough to negotiate
around an obstacle, reject the plot, record the rationale for rejection, and select the next available
RRQRR generated contingency plot. Shifts and offsets can be used separately or in tandem depending on
site conditions.

Points at corners and cardinal directions

If an obstacle prohibits placement (e.g. there is a rock or tree) of a corner or cardinal marker, shift the
plot marker to a better location that is < 0.5 m from the target location, record the rationale for the shift
in the metadata comments field, and record high resolution GPS data for the new location. If a plot
marker cannot be placed < 0.5 m of the target location proceed to offset the marker up to 4 meters.

It is acceptable to increase this 4 m offset distance threshold, however, if there are more than 5 plots
with an offset between 4 - 10 m or if at least 1 plot offset is more than 10 m, establish the offset and
contact Science.

If the offset is not enough to negotiate around an obstacle, reject the plot, record the rationale for
rejection, and select the next available RRQRR generated contingency plot.
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SOP C Plot Delineation and Marking

The following procedure contains instructions followed by a bracketed number [#] that refers to the
pointID. Plot pointID numbering is available in Error! Reference source not found. and delineation
schematic in Error! Reference source not found.. We recommend using the diagrams provided in
appendices previously outlined while conducting plot delineation.

Before getting started

e Check compass and Laser Rangefinder declination. Make sure the compass and rangefinder
have their declination set appropriately for the geographic location. Declination changes
through time so must be looked up annually for a given location. An incorrect declination will
result in shifted plots that will need to be re-delineated.

o Magnetic declination adjustment values are available at
http://www.ngdc.noaa.gov/geomagmodels/Declination.jsp

e Calibrate Rangefinder internal compass against compass. Ensure that the internal compass of
the Rangefinder has been properly calibrated by checking it against a standard mirror-site
compass in more than one direction.

o If the internal compass of the Rangefinder is not accurate, follow the calibration steps listed
in the ‘Configuring the rangefinder’ topic in RD[19].

o When checking compass calibration, take care that no metal objects are within 18 inches of
the compass or the Rangefinder—i.e. plot markers, watches, etc.

o The magnetic environment around certain buildings will completely prevent accurate
compass calibration in the Rangefinder.

e General Rules
o Measurements: The goal is to create plots of constant area when viewed from the air. Use

tape measure to delineate the plot unless site conditions make using the tape impractical
(e.g. steep slope, dense understory). If using tape measure is not possible, use the
rangefinder to delineate the plot. Use the rangefinder in slopes over 20%. When establishing
a plot where the slope of the ground is greater than 20%, measuring a distance of 10 m
along this slope with a tape will yield a horizontal line that measures less than 10 m from the
air. The same can be true if the tape has to go around large trees or over/below brush, see
obstruction methods in Error! Reference source not found..).
= Gullies and hills will, if large enough, require use of the rangefinder in order to meet this
requirement.

o Verification: when using the tape measure or rangefinder to delineate, use the rangefinder
to verify measurements. If only the rangefinder is used additional verifications can be made
by measuring from different angles/locations.
= |tis required that verification measurements are within *1 degree for the azimuth and

0.3 meters for the distance. For example, if the instrument is verifying a horizontal
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distance measured previously with the tape of 10.0 m, the rangefinder values for
verification should be between 9.7 and 10.3 meters to accept the verification.
o Plot delineation reminders:

o Always make sure the internal compass of the rangefinder is properly calibrated and
declination is properly set before beginning.
o Measure in increments of 10m or less. Greater distance results in more errors for the tape
and rangefinder
o Always keep metal objects (including flags, chaining pins, cell phones, watches, jewelry
etc.) at least 2 feet away from the rangefinder when using the internal compass.
o If you do use a sighting compass abide by the following rules to ensure accuracy:
o Check to ensure the adjustable declination dial is set correctly.
o Hold the compass at arms-length and keep all metal objects away.
o Make sure the compass is held level to allow free movement of the magnetic
needle.
Align the line in the mirror with the center of the needle while sighting your target.
Carefully align both sides and the points of the needle with the guides below it.

Bring the Log Sheets (Error! Reference source not found.) and fill them out once a plot has been
delineated.

Although plots are a variety of sizes, all follow a combination of the following four delineation
workflows. Tower Base Plots, Distributed Base Plots, and Tick Plots must all be delineated. Phenology
Plots, Bird Girds, Mammal Grids, and Mosquito Points all involve using pre-loaded points in the Trimble
to place markers on the ground. This delineation process is outlined based on a two person crew:

M Person 1 holds the rangefinder and measures angles and distances and
M Person 2 holds the reflector.

N _
50
Both crew members should have tapes, a handful of flags and 1 | ]r
chaining pins. The numbers in brackets below refer to the pointIDs, i 5
see appendix H for more information. i ’
. A | — S .
1. Establishing Cardinal Positions- 10m ™ [40] Ua1) (42]
a. Person 1, stand at the centroid with the Rangefinder and tape i
anchored at centroid [41] i
b. Person 2, take a compass bearing North (360/0°) and walk [321:}“
unspooling tape to 10m [50]
c. Person 2, turn toward centroid, hold up reflector (away from
face) directly above tape at 10m for Person 1 Figure 3. Plot Delineation step 1
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1) Person 1, shoot azimuth and distance to reflector, fine tune Person 2 to the targeted

azimuth position (e.g. 180°), then verify measurement including the instrument error of

11 degree.
2) Person 2, place a flag at the 10m N point [50]

2. Establishing Cardinal Positions- 20m ™

Person 1, stand at the centroid with the rangefinder and

tape anchored at centroid.

Person 2, take a compass bearing North (360/0°) and

walk unspooling tape to 10 meters [50]

Person 2, turn toward centroid, hold up reflector (away

from face) directly above tape at 10m for Person 1

1) Person 1, shoot azimuth and distance to reflector,
fine tune Person 2 position

2) Person 2 place a flag at the 10m N point [50],

Continue 10m N to establish the 20m N point [59]

1) Person 1, stand at point [50] with the Rangefinder
and tape still anchored at the centroid [41]

2) Person 2, take a compass bearing North (360/0°) and

walk unspooling tape to 20m [59]

d. Spool the tape to the centroid and complete repeat steps a-c for the remaining cardinal
directions: South [32] 180°, East [42] 90°, West [40] 270°.

>z

(32]

wo

e

I4

"
[42] [43]

Figure 4. Plot Delineation step 2

3) Person 2, turn toward point [50], hold up reflector (away from face) directly above tape

at 20m for Person 1

4) Person 1, shoot azimuth and distance to reflector, fine tune Person 2 position

5) Person 2 place a flag at the 20m N point [59]

Spool the tape to the centroid and complete repeat steps a-d for the remaining cardinal
directions at both 10m and 20m : South [32] & [23] 180°, East [42] & [43] 90°, West [40] &

[39] 270°.
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3. Establishing 20m by 20m corners e

f.

N . ¥
Establish North 20m x 20m plot corners (Error! g :L[Zg]_ _____ [EO_IE: ______ [Eﬁi
Reference source not found. and Error! Reference i i - E
source not found.) i i 3 i
1) Person 1 and Person 2 each anchor a tape at East '}.! ________ # _________ b
[42] and West [40] respectively with a chaining pin. i[“’] :[“” [“]E

2) From points [42] and [40], each person walks north i i E
(estimate visually) 10m i | E

3) Place chaining pins at the NE and NW corners [51] & élgs_u_ _____ @2_]:»» _______ @3]_'&(

[49], wrap tapes around pins

4) Turn 90 degrees toward the center line [50] (meet in Figure 5. Plot Delineation Step 3
the middle)

5) Anchor tape at 20m

6) Adjust corners [51 & 49] so that both sides of the tape are taut and the pins are placed
precisely at 10m

7) Once the tape is properly placed, mark corners [51 & 49].

Verify north layout of 20m x 20m plot

1) Person 1 stand at NW corner [49], Person 2 move to center [41]
a) Person 1 measure horizontal distance between the NW plot corner and the

centroid. Diagonal should measure 14.14 + 0.3 meters.

Repeat at NE corner [51]

Spool tapes

Establish south 20m x 20m plot corners (Error! Reference source not found.)

1) Facing south from points [42] and [40], follow step 1 above to establish SE [33] and SW
[31] corners.

Verify south layout of 20m x 20m plot

1) To verify southern layout, follow step 2 above to verify SE [33] and SW [31] corners.

4. Establishing 40m by 40m corners 4
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(Error! Reference source not found. and Error! Reference

source not found.). The remainder of the plot may be A i [SQ]FS """ i
completed relying on the tapes, only using the Rangefinder ‘ i | ‘
to verify diagonal distance. k! ot S |
a. Anchor 2 tapes to NW corner [49] ‘ i |
b. Walk one tape 10m North [58], verify with the Range | ®___ =& ____ 6_____ -
Finder shoot azimuth (360°) and 10m distance. - I[AO] 5[41] Wl
c. Place chaining pin on tape at the 10m. | ‘;r,; 77777 @?Lé‘!‘ 77777777 g, 777777
d. Walk the other tape from NW corner [49] to the West ‘ I
[48] 10m, verify with the Rangefinder shoot azimuth | ! i ; 1
(270°) and 10m distance. oo e s
e. Place chaining pin on tape at the 10m. Figure 6. Plot Delineation Step 4
f.  Wrap both tapes around 90 degrees, walk toward
Northwest most corner [57]
g. Clamp both tapes at 20m intersecting the tapes at Northwest corner [57]
h. To verify layout, stand at corner [57] and shoot the Rangefinder HD back from corner [49];
the distance should = 14.14m
i. Adjustif needed
j. Flag point
k. Repeat steps to establish remaining points:
1) [51], [60] & [52] = [61]
2) [33],[34] & [24] = [25]
3) [31], [30] & [22] = [21]
c1 Tower Plots

Tower plot dimensions depend on vegetation type and will be listed on the site datasheet (see Table 5).

20m by 20m Tower Plot

Follow: Establishing Cardinal Positions- 10m (Step Error! Reference source not found.)

Follow: Establishing 20m by 20m corners (Step Error! Reference source not found.)
Leave markers and collect GPS points at [41], [49], [51], [31], [33]. See SOP Error! Reference
source not found. for guidance on offsetting markers.

4.
5.

Use the GPS to take photos facing toward center from points [49], [51], [31], [33].
Fill out log sheet (Error! Reference source not found.)

20m by 20m Tower Plot with 40m corners for Soil Sampling

1.
2.

Follow: Establishing Cardinal Positions- 10m (Step Error! Reference source not found.)
Follow: Establishing 20m by 20m corners (Step Error! Reference source not found.)
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3. Follow: Establishing 40m by 40m corners (Step Error! Reference source not found.)

4. Leave markers and collect GPS points at [41], [49], [51], [31], [33], [57], [61], [21], [25]. See

SOP B.7 for guidance on offsetting markers.
5. Use the Trimble GPS to take photos facing toward center from points [49], [51], [31]
6. Fill out log sheet (Error! Reference source not found.)
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40m by 40m Tower Plots

N

Follow: Establishing Cardinal Positions- 20m (Step Error! Reference source not found.)
Follow: Establishing 20m by 20m corners (Step Error! Reference source not found.)

e Suggestion: Flags may be left at all 20x20m corners within 40m tower plots (where sites
permit), until tower plots with plant diversity sampling are accepted.

Follow: Establishing 40m by 40m corners (Step Error! Reference source not found.)

Leave markers and collect GPS points at [41], [57], [59], [61], [43], [25], [23], [21], [29]. See
SOP B.7 for guidance on offsetting markers.

Use the Trimble GPS to take photos facing toward center from points [57], [61], [21], [25].
Fill out log sheet (Error! Reference source not found.)

40m by 40m Tower Plots with 20m corners for Plant Diversity Sampling

C.2

il

4

Follow: Establishing Cardinal Positions- 20m (Step Error! Reference source not found.)
Follow: Establishing 20m by 20m corners (Step Error! Reference source not found.)
Follow: Establishing 40m by 40m corners (Step Error! Reference source not found.)

Leave markers and collect GPS points at [41], [49], [51], [31], [33], [57], [59], [61], [43], [25],
[23], [21], [29]. See SOP B.7 for guidance on offsetting markers.

Use the GPS to take photos facing toward center from points [57], [61], [21], [25].

Fill out log sheet (Error! Reference source not found.)

Tower Phenology Plot

Located within the tower airshed (RD[09]). See workflow sheet in Error! Reference source not found..

1.

2.

Primary Phenology Plot: 8 points every 100 meters around square transect.
a. Navigate to preloaded points with GPS receiver.
Place primary markers at the SW and NE points, the remaining points require secondary
markers.
c. Collect GPS points (refer to SOP D)
Use the GPS to take photos in a clockwise direction at all points
e. Marker type and labeling instructions located in Error! Reference source not found.. See
SOP B.7 for guidance on offsetting markers.
f.  Fill out log sheet (Error! Reference source not found.)
Secondary Phenology Plot: line contains three points. Not applicable for all sites (refer to
tower data sheet in FOPS folder).
a. Navigate to preloaded points. Place primary marker at SW corner, remaining points require
secondary markers.
b. Collect GPS points (refer to SOP D)
c. Use the GPS to photos in a clockwise direction at all points
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If possible, place temporary flags as needed along transect to visually guide phenology
sampling efforts. For more details, refer to RD[09].

Marker type and labeling instructions located in Error! Reference source not found.. See
SOP B.7 for guidance on offsetting markers.

Fill out log sheet (Error! Reference source not found.)

Distributed Plots

Cc3

i s

b

c4

Distributed Base Plot

Follow: Establishing Cardinal Positions- 20m (Step Error! Reference source not found.)
Follow: Establishing 20m by 20m corners (Step Error! Reference source not found.)
Follow Establishing 40m by 40m corners (Step Error! Reference source not found.)

Leave markers and collect GPS points at [41], [49], [51], [33], [31], [61], [25], [21], [57]. See
SOP Error! Reference source not found. for guidance on offsetting markers.

Use the GPS to take photos facing toward center from points [49], [51], [31], [33].

Fill out log sheet (Error! Reference source not found.)

Distributed Tick Plots

Once at the plot verify that at least 50% of the plot perimeter (i.e., 80m of the 160m perimeter) is
amenable for tick sampling using the dragging or flagging method(s) (or both). For example, sections of
the perimeter that run through dense patches of briars likely cannot be sampled by either method.
Additional information can be found in RD[06].

el

Follow: Establishing Cardinal Positions- 20m (Step Error! Reference source not found.)
Follow: Establishing 20m by 20m corners (Step Error! Reference source not found.)

Follow: Establishing 40m by 40m corners (Step Error! Reference source not found.)

Leave markers and collect GPS points at [41], [57], [61], [25], [21]. See SOP Error! Reference
source not found. for guidance on offsetting markers.

Fill out log sheet (Error! Reference source not found.)
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49 51
Loood0m oo
41 o
20m
31 o 33
NJ4.14m
21 25
o Stainless steel primary plot marker with unique plot ID+ GPS N
®  Secondary (pve or rebar) marker + GPS ¢
B pestructive sampling area
Figure 7. Plot layout and marker positions for 40 m by 40m Distributed
Base Plots
C.5 Distributed Mammal Grid

See workflow in Error! Reference source not found..

1. Locate the desired plot centroid with GPS reciever, using pre-loaded waypoints and/or data
files.

2. Mark the plot centroid. See SOP Error! Reference source not found. for guidance on offsetting
markers.

3. Locate the plot corner with the GPS receiver, using pre-loaded waypoints and/or data files.

See SOP Error! Reference source not found. for guidance on offsetting markers.

Mark plot corner

Repeat steps 3-4 for remaining corners.

Set up grid before sampling as outlined in Small Mammal protocol.

Fill out log sheet (Error! Reference source not found.)

No vk
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Cc.6 Distributed Bird Grid
See workflow in Error! Reference source not found..

1. Locate the desired plot centroid with GPS receiver, using pre-loaded waypoints and/or data
files.

2. Mark the plot origin, if the latter is not yet available use a temporary marker. See SOP Error!
Reference source not found. for guidance on offsetting markers.

3. Collect GPS point

4. Bird Grid preloaded points will be provided for use when sampling.

5. Fill out log sheet (Error! Reference source not found.)

C.7 Distributed Mosquito Point
See Workflow in Error! Reference source not found..

1. Locate the point with GPS receiver, using pre-loaded waypoints and/or data files.
2. Validate the point

a. Point must be at least 5m from a road and a maximum distance of 45 m.

Shift the point within 10m in any direction if needed to find an acceptable hanging structure
and/or increase distance from the road. For more details, refer to RD[05]

c. Validate the vegetation within a 40m by 40m box around the point following the canopy
cover assessment of SOP B. Exclude the road during this assessment, for example if 30% of
the 40 by 40 m plot is road, exclude this 30% and assess the plot based on the
remaining 70%.

d. Fill out the data dictionary

3. If accepted mark the point with a primary marker, use a temporary marker if primary marker is
not yet available.

4. Collect the GPS point

5. Fill out log sheet (Error! Reference source not found.)
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SOPD Collect GPS coordinates

After delineating a plot, GPS coordinate collection follows. To collect highly accurate coordinates, set up
surveyor style standing GPS system (Error! Reference source not found.):

1. Monopole set up:
a. Set up monopole directly on top of the point to be measured
b. Add bipod legs to ensure stability.
2. Connect the antenna and GPS:
a. Connect cable to the antenna.
Screw antenna to the top of the monopole.

c. Connect the other end of the antenna cable to the GPS unit; connector is located in the
upper right side of the unit.

d. Open the monopole clamp and attach it to the monopole.

e. Open the GPS clamp and attach it to the GPS unit.

f.  Attach the GPS clamp to the quick release mount in the monopole clamp.

g. Make sure the system remains stable.

Figure 8. GeoXH 6000 set up for high accuracy
data collection.
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Table 6. Points to be logged by FOPS (also see workflow for each plot type in Error! Reference source not found.).

. GPS points collected
Provided by Total
Plot_Type Sub_Type Module Science by FOPS fo_r Post Points
Processing
Centroid, 4 corners of
Distributed Base Base Centroid 20m plot, 4 DSA 9
corners (40m)
Distributed Collocated Mammal Centroid, corners Centroid 1
Distributed Collocated Bird (;entr0|d, I pt gr.ld Centroid 1
(includes centroid)
Distributed Collocated Mosquitoes Centroid Centroid 1
Distributed Collocated Ticks Centroid, 4 Centroid and 4 5
Corners Corners
Centroid, 4 outer
Tower Type A nger-mm by Centroid corners, 4 cardinal 9
points
Tover4mby Co, e
Tower Type A 40m with plant | Centroid ’ ) 13
. . corners, 4 cardinal
diversity .
points
T -2
Tower Type A ngr:/]er Om by Centroid Centroid, 4 corners 5
Tower- 20m by Centroid, 4 inner
Tower Type A 20m with DSA Centroid corners, 4 outer 9
corners corners
i I
Tower Type B Phenology 1H 8 pts on transect 8 points along 8
transect
Tower Type B Phenology 2H 3 pts 3 pts 3
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3. Acquire GPS location
Begin the collection of the first point within the plot:

a.

1)

Make sure that the Antenna Height is at 2 m, and the Type refers to the Antenna Model.
Keep setting on “measure to bottom of receiver”; then click OK on “confirm antenna
height” pop-up.
Open the first feature of the current file (generally centroid point or other origin point is
the first)
To ensure High-Accuracy Logging
Make sure your values are:

e Position Dilution of Precision (PDOP) is < 6.

e The Signal to Noise Ratio (SNR) should be > 4.

e Number of satellites used >4.

These measurements are located on the bottom right of the MDD > skyplot in
the TerraSync software on the Trimble unit.

Allow the GPS to log positions (note the logging symbol in the upper right side of the
screen). Depending on the canopy cover choose the appropriate action:

e Open field or minimal canopy cover: record GPS data for at least 120 logs using the
accuracy-based logging feature.

o If the data collection of each point takes over 20 minutes, disable logging
feature (see below) and collect the 120 logs regardless of accuracy. Once you
are back at the domain office please contact Science and provide the list of plots
with this issue.

e Semi-open and closed canopy: record GPS data for at least 300 logs using the
accuracy-based logging feature.

o If the data collection of each point takes between 5 and 10 minutes, disable the
logging feature (see Box 1) and collect the 300 logs regardless of accuracy. Once
you are back at the domain office please contact Science and provide the list of
plots with this issue.

Use your judgment in regards to exactly how long to wait at each point
(always a minimum of 5 minutes). Create your judgment by assessing
potential permanent obstructions like canopy cover, boulders,
mountains etc., and based on any preceding results from post
processed data received from SCIENCE (when available).

e For all canopy conditions:
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o Verify that carrier lock and a minimum estimated accuracy of 0.5 m is
maintained for the duration of the logging. If accuracy drops check that the
skyplot information is following high accuracy standards. To view carrier lock
scroll to Status in the upper left drop down and the scroll to Receiver in the
lower left drop down menu.

o Following the completion of the first day of collection under closed canopy or
semi-open canopy conditions, notify HQ to verify that the accuracy
requirements are being met. Note: it takes 24-48 hours to post-process data.
After the post-processing accuracy check, you may be required to log more data
to meet accuracy; this depends upon plot conditions.

This feature is already enabled if you completed the GPS Setup in Error!
Reference source not found..

4. Tap Done to store data. Close the feature but NOT the data file.
5. The following screen should return to the display all features that a required to be completed

for the plot at work.
There are several scenarios that could follow. Select the appropriate one:

If you are at the center point, once this first point is collected and the feature is closed
move the monopole to next feature.

Or

If a picture follows the work flow, you can take the picture while the GPS is attached to
the monopole. Make sure pictures are always taken facing the center of the plot. To
take a picture open the photo feature, tap on the photo icon to the right of the blank
box. To take the picture tap on the physical camera button located towards the bottom
center of the GPS underneath the screen. Once a photo is taken tap OK/Done.

Or

Once the last point in the plot is collected Close the file and Save all changes. Collect all
equipment and hike to the next plot.
e Optional: To quickly verify that all required points have been collected, before
closing the file:
o Use the MDD to view the Map.
o Zoom to the area where your plot is located.
o Visually confirm that all features have been collected (each logged feature will
be displayed as an “X” on the map)
o Photo icons will only be displayed if logs were taken while the photo feature is
open, which will not always be the case
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Box 1. Disabling the Accuracy-Based Logging Feature

Go to MDD > Setup

Click on Logging Settings

Under Logging Settings click on the wrench #|to the right of the screen.
Scroll down and in the Use Accuracy-based Logging click No

Click Done for the two following windows and,

To go back to the data collection go to MDD>Data + SDD>Existing File.

IR U

By disabling this feature, the GPS will collect data of any accuracy. For
information about setting up the accuracy based logging feature see Appendix
B, step 4.
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SOPE

Data Entry and Verification

As a best practice, field data collected on paper datasheets should be digitally transcribed and
transferred to the shared folder for post-processing by Science staff as soon as possible following plot

establishment. Ideally this will occur daily at sites where internet access is available. However, given
logistical constraints, the maximum timeline for entering data is within 14 days of collection. See RD[04]
for complete instructions regarding manual data transcription.

Once back from the field, make sure to:

E.1

Transfer data from GPS handheld to computer (see section SOP Error! Reference source not

found.).

Update all fields in the FOPS drive for:

o XX_X_TOS_Plots_Datasheet (e.g. 05_C_TOS_Plots_Datasheet). The naming convention and
format of this document are subject to change.

If it is the first day of collection under a closed or open canopy forest, through e-mail, notify

Science that there is data available for post processing.

Transferring data from GPS handheld to PC

Open Pathfinder Office software
Open the previously created project (created in step A.5)
Pathfinder does not save previously set coordinate systems, make sure to update the
coordinate system when transferring and verifying data, see SOP A.4 for details.
Connect the Trimble to the computer with the USB cable, and power on the unit.
The Windows Mobile Device Center (Win7 or Vista) should pop-up displaying a connection of
the device to Windows. Select “Connect without setting up my device.”
Within Pathfinder Office, use the Data Transfer utility to transfer the .ssf file to the Trimble:
a. Go to Utilities > Data Transfer... and in the window that opens, click the “Receive” tab and
then click Add... and select Data File from the list and click Open.
b. After selecting all data files relevant to all the new plots recorded, click Transfer All.
The .ssf files will be transferred automatically. Make sure all files are transferred to the shared
folder. Science staff will post process the data files.

If certain points don’t meet the accuracy requirements, the corresponding points will have to be
re-measured.

Once data have been transferred, disconnect GPS from the computer.
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E.2 Data Verification
Once the data is transferred complete the following quality checks:

1. Make sure that the data file is correctly named, see SOP Error! Reference source not found..
To view filenames go to the folder where files were downloaded.

If the filename is incorrect, make sure that the name is changed in the GPS unit before
transferring the data to the computer. This ensures that the original, backup, and photo files all follow
the same naming convention.

a. Turn on the GPS unit
Open the Terra Sync Software

c. Oncein Terra Sync, tap on the MDD (Main Drop Down) menu located to the upper left side
of the screen and select Data.
Tap on the SDD (Sub Drop Down) menu located beneath the MDD and select Manager.

e. Below the SDD there should be a box with the list of existing data files, select the file to be
renamed.

f.  Once the file is selected, tap on the options menu located parallel to the SDD in the upper
right side of the screen and select the Rename option.

g. The screen will display the file in question highlighted

h. Edit the datafile name

i. Once the rename is complete, tap outside of the filename highlighted area and this should
establish the new name of the file.

j.  Once the datafile name is modified, transfer the file to the computer through the Pathfinder
transfer tool (see SOP Error! Reference source not found. for instructions)

k. Make sure that the incorrectly named files are deleted from the shared folder.

2. Make sure the spatial location of the point ID is accurate, for example: point ID 41 should be in
the center of the plot. To do this spatial check open the .ssf file in pathfinder office. To view the
spatial location go to the main pane of Pathfinder and click on View > click on Map. To view the
pointID in the file go to the main pane and click on Data > then click on Feature Properties.

If the point ID is incorrect make sure an e-mail is sent to Science staff with both the incorrect
pointID and the intended pointID.

3. Send your Science point person an e-mail to notify them about the added data ready for post
processing.

4. Update the worksheet daily (Table 5 in folder “Site_Information_&_Datasheet”). See SOP A,
section A.8 for more information.
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E.3 Post-hoc mission analysis: Working for higher accuracy in challenging locations

Once the collected GPS data are sent to Science, they will be post processed and assessed to determine
if points meet the accuracy standards. Field technicians will recollect any data that require re-
measurement. If re-measurement is required the mission planning can be a useful tool to make sure
that measurements will be collected at the best time of the day. Please complete the following steps for
mission planning when re-measurement occurs:

1. Go to http://www.trimble.com/GNSSPlanningOnline/#/Settings
2. To begin, click on the Setting link located in the upper left side of the window:
a. Add the latitude and longitude of one of the plots within the site to visit. Look in (RD [50])
for the latitude and longitude.

b. If the challenging areas are located close to obstructions like mountains, cliffs, or valleys use
the Obstructions tool to define the open sky area available (Error! Reference source not
found.). Make sure the azimuth where the obstruction occurs is acquired. For example if
there are mountains within sight located at 95°azimuth and 20° elevation:

1) Start by clicking on the blue circumference on the area around 95° where the
obstruction occurs. The blue circumference (represents a clear sky view) will allow the
modification of the view. Modifying the blue circumference to align with the actual sky
view available at a particular location of measurement will allow for a better assessment
of satellite availability.

Define Obstruction Curtaie

Figure 9. The Obstructions tool within the Trimble Mission Planning web-based software
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2) After clicking on the line, several nodes should appear. There are two ways to apply the
azimuth and elevation to the central node:

e To the right center of the screen there should be three items representing the three
nodes, with specs on the azimuth and elevation. Click on the pencil icon in the
second item (should represent the central node) and type the azimuth and
elevation, press Enter, the obstruction curtain should be recorded.

Or

e Drag the center node to 95°. Once the node is in the right place, use the same
center node and drag it inward, to a window should appear to the right and the
second item should reflect the azimuth and elevation of the moving target. Make
sure that the node ends up at 95° azimuth and 20° elevation. Don’t worry about the
outer nodes unless the width of the obstruction is significantly different than the
one shown on the circumference (Error! Reference source not found.).

Define Obstraction Curtain

Oefine Obstruction Curtain

| oene

Figure 10. Adding an obstruction observed in the field within the Trimble Mission Planning software.

3) Once the desirable obstruction curtain is created click Apply and an updated satellite
histogram should be created.

c. Select the field Day
Select the starting time or Visible Interval and the time span in hours (generally a 6 or 12

hour span).
e. Select the appropriate Time Zone.
f.  Click Apply
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3. Click on the Satellite Library

a. Click on the GPS and the GLONASS satellite libraries; unclick the rest of the satellite libraries.

4. Click on the Number of Satellites

This histogram will display the number of satellites (GPS and GLONASS) available on the day and
times previously set up in the settings window. The higher the number of satellites available, the
better the accuracy will be. This graph will allow field workers to know when the best times to

establish challenging plots may or may not be.

@ If there is a time in the day where satellite availability is poor, take this time to hike or do

activities other than collecting coordinates.
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SOPF Re-visiting GPS locations
F.1 Re-measuring GPS locations

If a point does not meet the required accuracy the first time around, the following steps will be used
either separately or in combination during subsequent re-measurements. If applicable, a list of points
that have to be re-measured can be found on the second tab in the site-specific datasheet. In most
cases FOPs will be asked to attempt re-measurement up to 4 times.

1. Wait until leaf off canopy
a. If the point that needs to be collected is under deciduous leaf canopy the best solution
is to wait until the leaves drop and there is no longer any canopy cover.
2. Double or Triple the amount logs. In some cases this could be as many as 800 to 1000 logs per
high-accuracy point.
3. Utilize mission planning
4. Even one or two additional satellites can make a huge different in reaching accuracy.
5. Utilize the carrier time technique.

This method utilizes open canopy areas for satellite communication before collecting logs in the
closed canopy. Staff will either need two GPS units (one for logging, one for navigating) or be
able to re-locate the re-measurement point from an open canopy location without the use of a
GPS unit.

e In open canopy make a new file, click create, confirm the antenna height, and choose
point generic.

e Without logging points wait until you have at least two minutes of carrier lock. To view
carrier lock scroll to Status in the upper left drop down and the scroll to Receiver in the
lower left drop down menu.

e Note: Two minutes of carrier time might take longer than two minutes to acquire

e Once you reach two minutes, hike to the point that will be re-measured without closing
the file you just created.

e At the point log the appropriate number of logs and pause the logging.

e Without clicking “done” or closing the file return to the open canopy area and wait until
two minutes of carrier time is obtained.

e Close the file.

At certain sites it is not possible to meet the science accuracy requirements through the current
workflow due to factors entirely out of the control of the field teams collecting the data (e.g. rugged
topography, blocked horizons, a lack of CORS stations by which to post-process). Reference Appendix J
about utilizing a base station and work with Science staff to determine the best path forward for your
particular site. Some indications that a base station may be necessary are:
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e If your re-measurement rate is over 30%

e If entire plots are requiring re-measurement

e Post processed accuracies are routinely above 1m

e There are no CORs or state base stations within 200km of the site

While these indicators are not always available to operators working in the field, should technicians find
themselves in a situation where a site requires an extremely high rate of re-measurement they should
bring it up with Science.

F.2 Lost Plot Markers

If markers cannot be located on subsequent visits to the plot after establishment has occurred
used the following steps to re-mark the plots.

1. Use the established .imp file corresponding to the site and plot type to find the
previously created location. This file is created after plot establishment has occurred
and will be located in a site specific folder.

a. When remarking this point, make sure that the Current Estimated accuracy
(CEA) is 50 cm or less.

i. The CEA is generally indicated on the upper right area of the Trimble
unit (this may differ depending on the terrasync and Trimble GPS unit
version)

b. If a CEA of 50cm or less cannot be achieved then follow the delineation steps in
SOP C to re-create the point location.
2. Place a new marker in the ground.
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SOP G Sample Shipment

This protocol generates no samples for shipment
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SOPH Plot Monumentation

Monumentation requirements are expected to vary from the standard monuments described in this SOP
at many sites and/or NLCD subtypes. In these cases, FOPS personnel should confirm the alternative
monuments meet science requirements with Science personnel via NEON’s problem tracking application
(e.g. JIRA). Sites in different domains will also have differing requirements for the length of monument
rod needed for permanent installations, usually determined by the depth of the frost line or unique
substrates, which will need to be determined by domain personnel in conjunction with Science.

H.1 Permanent Marker Installation

1. If permanent monuments are not installed as part of plot establishment, begin by navigating to
target plot and corner using a map, GPS, compass, and/or tape measures as needed. Refer to
the Appendix A for instructions on which plot corners require permanent monuments. If
temporary plot markers are present, use a pry bar to remove them (Fig. 11).

Figure 11. Removing prexxisting plot markers with a pry bar

2. Assemble the initial monument assembly by threading a driving point below a rod and the
driving adapter above the same rod section using the supplied threaded connection pins. Pliers
can be used to ensure a tight connection between the different sections. Place the monument
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assembly with the driving point down into the hole left by the temporary plot marker (Fig. 12).
At plots without a preexisting temporary plot marker, lightly tap the monument assembly a few
inches into the ground using the sledgehammer as a hand hammer (i.e. grip the sledge hammer
very close to the head).

3. Continue to drive the monument into the ground using the post driver. This is a deceptively

hazardous action requiring cautious attention to several factors:

a. Occasionally the rod assembly sections may slightly separate while driving the monument
into the ground as the connections tend to move a little counterclockwise during each hit
(Fig. 12). Because damage can occur to a rod section or threaded connection pin if a gap
forms between the monument assembly sections, frequently pause driving the monument
assembly into the ground (approximately every 10-20 strikes) to check for and tighten any
loose connections.

Figure 12. Do not allow the monument assembly sections to become separated while striking

b. Do not lift the post driver too high during the striking motion as this may allow the bottom
of the post driver to rise above the top of the monument assembly. This situation is
dangerous as the worker could miss the monument on the down stroke of the striking
motion and potentially hit their leg with the post driver or hit their hand against the top of
the monument assembly (Fig. 13). If the worker can see scored line about 1 inch below the
driving adapter (Fig. 12) at any point during the striking motion they are probably raising the
post driver too high.
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Figure 13. Do not lift the post diver above the top of the rod during the striking motion as the worker could injure their leg or
hand

¢. Adjust your body position as needed from a standing to a kneeling stance as the top of the
monument is driven closer to the ground. Operating the post driver above your body
reduces control of the driver, while operating the post driver below your body may allow
the driver to strike the worker in the head.

4. When the monument has been driven far enough into the ground so that A) the post driver
almost hits the ground at the bottom of the striking motion or B) the worker is making the
striking motion at an uncomfortable height/angle and the required monument rod length has
not been reached, unthread the driving adapter from the top of the monument, thread another
monument rod section onto the top of the monument assembly in the ground, and thread the
driving adapter onto the top of the new monument rod section. Repeat step 3 and 4 until the
required monument rod length has been reached.

5. When the monument has been driven far enough into the ground so the post driver almost hits
the ground at the bottom of the striking motion and the final monument rod section needed to
reach the required depth has already been attached, finish driving the monument assembly
close to the final height by repeating step 4 using a spare 2’ monument rod section threaded
above the final monument section. Repeat step 3 until the top of the final monument rod
section is a few inches above ground level, at which point the driving adapter and spare
monument rod section are removed.

6. Place the respective monument cap on top of the final rod section. Use a sledgehammer to seat
the monument cap squarely on the final monument rod section and drive the final monument
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assembly to the final desired position (Fig. 14). Ensure the cap is secure after work has been
performed.
a. Monument caps cannot be ordered until plot acceptance is done and the unique plot
IDS created. Plot IDS are created by Science staff after the final list of accepted plots is
available.

Figure 14. Use a sledgehammer to seat the cap and drive the rod to the desired position

H.2 Cutting a Monument Stake

Occasionally a monument is driven to refusal (i.e. the bottom has reached an impenetrable barrier)
before reaching the site specific preferred or minimum length, which leaves a length of rod still above
ground and must be cut off or removed.

1. If the minimum monument length has been reached, use a hand or power saw to remove any
extraneous monument rod.

a. Use a marker to make a mark at the desired final height of the monument rod.

b. Pierce the center of a paper plate and push the plate down the monument rod through
this hole so the plate is resting on the ground. This plate will serve as a containment
area for any metal shavings generated during the cutting process. Properly dispose of
the shavings after work has been completed (i.e. at the support facility).

c. Slowly and carefully saw horizontally through the monument at the height mark, being
cautious near the end of the cut to maintain control of the saw and prevent large burrs
on the rod.
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d. Place the respective monument cap on top of the final rod section. Use a sledgehammer
to seat the monument cap squarely on the final monument rod section and drive the
final monument assembly to the final desired position (Fig. 14).
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APPENDIXA  LOG SHEETS
How to use the Mission Planning/Assignment Sheet

The Mission Planning/Assignment Sheet provides a standardized format for tracking each plot
establishment team’s progress on a daily basis:

o Asthe day’s activities are being planned, each team can write down the plots they should (or
might possibly) visit. When possible, it is useful to list the plots in the order they are to be
visited so that the team can simply work their way down the list. Fill in as many details about
each plot as are necessary to do the work: Morton order number, plot type, NLCD class, etc. If
the task list includes a revisit to collect more GPS data, write down the points to be re-logged
and the file version to be used (V2, V3, etc.).

e In the field, the team can use the checkboxes and note fields to record progress and any
deviations from the expected plan. If the work was carried out according to plan, simply check
off the “Task Completed” box. If the team was not able to finish the planned tasks, check “Task
Partially Completed” and take notes on what work remains to be done. If the plot is rejected,
check off the “Plot Rejected” and record why.

e At the end of the day, the team should finalize any notes and check off “Not Visited” for any
plots the team did not make it to. Then use the log sheet to update the “plots datasheet” on
the GIS drive and any master checklist or progress map that domain staff may have developed.

e later on, these log sheets are available as resources to plot establishment coordinators as they
try to troubleshoot and track down loose ends, for example: “I have a question about plot X;
which technician should | talk to about it?” Or, “I thought we had re-visited that plot to re-log
point 23 but | can’t find the file. Was that work never done in the field or did we just miss a file
during the data upload? Which GPS unit was used, anyway?”

How to use Plot Maintenance Logs

Plot Maintenance Logs provide a long-term record of plot-specific details that are not otherwise tracked
under this protocol. Side one (plot type specific; A.2- A.9) is for documenting the initial plot
acceptance/delineation visit. It contains a diagram showing the plot’s configuration and fields for
metadata such as Morton order number, personnel who did the work, etc. Side two (marker
installation; A.10) contains fields for notes on subsequent visits (for example, to install permanent
markers or to seasonally break down/re-establish the plot). The teams performing this later work can
either take the original with them and update it in the field (suggestion: scan/photocopy the original
first to ensure there is a backup) or update the log sheet in the office at the end of the day.
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During plot establishment, each plot acceptance team should carry enough of these sheets to cover all
possibilities for the day. Once a plot is accepted, the team can record:

e type(s) of markers used

e |ocation of any offset markers

e |ocations of streams, boulders, trails, or any other features that might complicate sampling
e  suggested route to plot

[ )

metadata such as personnel who accepted and delineated the plot

Many of these details can simply be sketched onto the plot diagram, providing a visual record (see
example below). In terms of workflow, a good time to fill out the Plot Maintenance Log might be at the
end of the delineation process, when one team member is finishing up the GPS work and other team
members are unoccupied.

PLOT MAINTENANCE LOG
Domain:___ D[/ site: Aéé | Morton Order:__ 7% plotiD;_ (025
h
i STREAM
fo 29 L Plot Map: Base Plot |61 Example
L N\ O 1 0 W R o (P Z Y
(0 ¥ 57 s 6 :
= e G STEEE LT RACRE .l g '
(¢ % S .
' ! Ny oy i
L 25 i 5
; ~ v Tt H
: - AWl ¢ Plot Markers Used
4..9.-.- /%’JL e _.l'-;l ! Y Primary Markers Duc.
“':" A f A Marked With:_pl=cir.
3 i ‘ .Sacondarvl\hrkersr =4
o j Marked With:_plz.i 7
i= . © Qptlonal Marker Pasitions
4 b 2 _ Marked With: p (/5 <
: | pir S5
E What to Record
i ! i1 = Check off positions
3 33 ! where markers installed.
32 / : \i
e /ARt Note any offset markers.
. * Note pools, streams,
! boulders—anything that
p : \ may complicate
21 25 sampling. leird
S T i o _I‘/ \ . Al (a -
& e " e

Figure 15. Example of how to use a plot maintenance log sheet

Page 67 of 117




neen

Title: TOS Protocol and Procedure: Plot Establishment

Date: 03/20/2017

National Ecological Observatory Network

NEON Doc. #: NEON.DOC.001025

Author: E. Azuaje

Revision: F

A.l Mission Planning and Assignment Sheets
Plot Information Task Information
Mort. Order/PlotiD| % O Tower O Mammal (NLED Class = OPlot Acceptance More Details & O Plot Accepted/Task Completed
FE' O Phenology O Mosquito E O Establish/Repair Grid § O Plot Rejected
Eo O Base O Tick O GPS Revisit § O Task Partially Completed
O Bird [} O Other === Q!0 Not Visited
Location Notes/Directions : Completion Comments
Moart. Order/PlotiD| & O Tower O Mammal (NLCD Class = O Plot Acceptance More Details & O Plot Accepted/Task Completed
l‘::: O Phenology O Mosgquito .Fﬂ § O Plot Rejected
-E O Base O Tick = § O Task Partially Completed
O Bird O Q: O Not Visited
Location Notes/Directions ; Completion Comments
Mart. Order/PlotiD| %0 Tower O Mammal (NLCD Class = OPlot Acceptance More Details & OPlot Accepted/Task Completed
Ao Phenology O Mosquito E O Establish/Repair Grid § O Plot Rejected
g O Base O Tick = O GPS Revisi § O Task Partially Completed
O Bird O O Other === Q!0 Not Visited
Location Notes/Directions i Completion Comments
Mort. Order/PlotiD| §:0 Tower O Mammal (NLED Class & OPlot Acceptance More Details & OPlot Accepted/Task Completed
FE O Phenology O Mosquito E O Establish/Repair Grid § O Plot Rejected
-5.9 O Base O Tick O GPS Revisi § O Task Partially Completed
O Bird [mi O Other = = Q!0 Not Visited
Location Notes/Directions : Completion Comments
Mort. Order/PlotiD| §:0Tower O Mammal |NLED Class & O Plot Acceptance More Details & O Plot Accepted/Task Completed
FS O Phenology O Mosquito E O Establish/Repair Grid g O Plot Rejected
"5? O Base O Tick O GPS Revisit E O Task Partially Completed
O Bird [mi O Other === Q!0 Not Visited
Location Notes/Directions ; Completion Comments
Mort. Order/PlotiD| %O Tower O Mammal (NLED Class & OPlot Acceptance More Details & O Plot Accepted/Task Completed
FE' O Phenology O Mosquito E O Establish/Repair Grid § O Plot Rejected
Eo O Base O Tick O GPS Revisit § O Task Partially Completed
O Bird [} O Other === Q: 0 Not Visited
Location Notes/Directions i Completion Comments
Mort. Order/PlotiD| &0 Tower O Mammal (NLED Class X O Plot Acceptance More Details % O Plot Accepted,/Task Completed
'S O Phenology O Mosgquito E O Establish/Repair Grid § O Plot Rejected
'iq O Base O Tick O GPS Revisit E O Task Partially Completed
O Bird O O Other === °© O Not Visited
Location Notes/Directions : Completion Comments
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A.2 Distributed Base Plot Log Sheet
PLOT MAINTENANCELOG
Domain: Site: Morton Order: Plot ID:
Plot Map: Distributed Base Plot 61 Example
- @
57 61 4.' i Marker
@ 77777777777. ; Note: Post offset 2.3m
Marker [ | Marker [ | _ 230 N
49 51 Plot Markers Used
® 0 'Y ¥ Primary Markers
Marker [] | Marker [] i Marked With:
i @ Secondary Markers
Marked With:
1 © Optional Marker Positions
4<0 * 4&? Marked With:
Marker [] i
Alum. Cap [] E
i What to Record
+ Check off positions
31 37 33 where markers installed.
. Note any offset markers.
Marker [] Marker []
e * Note pools, streams,
Alum. Cap[] .
boulders—anything that
may complicate
21 sampling.
. .........................................................................................................
Marker : Marker L
Initial Establishment Visit
Date Accepted: Field Crew:
Trimble GPS Used: All GPS Points Attempted? oY /o N
Plot Nickname: Plot Delineation Completed? oY /o N
Comments:
Please be detailed about any GPS points not logged/delineation work still to be done.

Page 69 of 117



n e :.) n Title: TOS Protocol and Procedure: Plot Establishment Date: 03/20/2017

NEON Doc. #: NEON.DOC.001025 | Author: E. Azuaje Revision: F

National Ecological Observatory Network

A3 Tick Plot Log Sheet
PLOT MAINTENANCE LOG
Domain: Site: Morton Order: Plot ID:
Plot Map: Tick Plot 61 Example
-@
57 61 & i Marker
.77777777777777777777777777777777777777777777777777777777777. : Note: Post offset 2.3m
Marker [} Marker [ | L @z
Plot Markers Used
Yo Primary Markers
Marked With:
@ Secondary Markers
Marked With:
41
M 'k“'*
Alumélc‘;;g What to Record
¢ Check off positions
where markers installed.
Note any offset markers.
* Note pools, streams,
boulders—anything that
Marker[[] i may complicate
Alum. Capi[] | sampling.
21 25
Marker [
Initial Establishment Visit
Date Accepted: Field Crew:
Trimble GPS Used: All GPS Points Attempted? oY /o N
Plot Nickname: Plot Delineation Completed? oY /oN
Tick Drag/Flag Evaluation (oY / o N) : Field technicians will be able to drag and/or flag
at least 50% of plot perimeter. (If the answer is “N”, reject the plot!)
Comments:
Please be detailed about any GPS points not logged/delineation work still to be done.
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A4

Small Mammal Grid Log Sheet

PLOT MAINTENANCELOG

Domain: Site: Morton Order: Plot ID:

Plot Map: Small Mammals Grid

Al

1
Marker [] !

Marker [}

Plot Markers Used

Y Primary Markers
Marked With:

@ Secondary Markers
Marked With:

i What to Record
ES i« Check off positions

Mal.ke‘.ﬁ where markers installed.

Alum. Cap [] Note any offset markers.
* Note pools, streams,

boulders—anything that

may complicate

sampling.

+ Corner points
(A1,J1,A10, J10) will be
provided in imps, no
delineation is done in the
field.

Al0

Marker [] Marker [

Initial Establishment Visit
Date Accepted:
Trimble GPS Used:
Plot Nickname:
Comments:

Field Crew:
All GPS Points Attempted? oY/oN
Plot Delineation Completed? oY /oN

Please be detailed about any GPS points not logged/delineation work still to be done.
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A5

Bird Grid Log Sheet

PLOT MAINTENANCELOG

Domain: Site:

Morton Order:

Plot ID:

Plot Map: Bird Gri

d Centroid

Plot Markers Used
¥ Primary Markers

Marked With:

’%;L %.2 ’?3 <! No marker. Not visited

during plot establishment.

B1 B2 B3

i _— * Bt What to Record

L\m;_‘a'{:;g » Check box(es) when
T marker(s) installed. Note
any offset markers.

c Q2 C * Note pools, stregms,

P boulders—anything that
may complicate
sampling.

Initial Establishment Visit
Date Accepted: Field Crew:
Trimble GPS Used: All GPS Points Attempted? oY/ oN

Plot Nickname:
Comments:

Please be detailed about any GPS points not logged/delineation work still to be done.

Plot Delineation Completed? oY /o N
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A.6 Mosquito Point Log Sheet

Domain:

PLOT MAINTENANCELOG

Site:

Morton Order:

Plot ID:

Marker []
Alum. Cap []

Plot Map: Mosquito Sampling Point

Plot Markers Used
¥ Primary Markers

Marked With:

What to Record
¢ Check off when markers

installed. Note any
offset markers.

Sketch road location and
give approx. distance.

If possible, the point
should be difficultto see
from the road. Note any
obstructions (big trees,
boulders, etc.) that also
may serve as landmarks
to help find the sampling
point.

Comments:

Date Accepted:

Initial Establishment Visit

Field Crew:

Trimble GPS Used:
Plot Nickname:

All GPS Points Attempted? oY/oN
Plot Delineation Completed? oY /o N

Please be detailed about any GPS points not logged/delineation work still to be done.

Page 73 of 117

Date: 03/20/2017




neen

National Ecological Observatory Network

Title: TOS Protocol and Procedure: Plot Establishment

Date: 03/20/2017

NEON Doc. #: NEON.DOC.001025

Author: E. Azuaje

Revision: F

A.7 Tower Plot Log Sheet- 40m by 40m
PLOT MAINTENANCELOG
Domain: Site: Morton Order: Plot ID:
Plot Map: 40m by 40m Tower Base Plot 61 Example
-@
57 59 61 p
@ - @ e - ' - 3
Marker [] ! Marker Marker [] )
: Plot Markers Used
49 51 i i
A 500 A : ¥ Primary Marlferrs.
Marker [] Marker [] : Marked With:
: @ Standard Secondary Markers
! Marked With:
I ; A Additional Secondary Markers
39 20 1 42 43 for Div./Soils Tower Plots
L ° * ° [ ] Marked With:
Marker [] | Marker [] Marker []: . .
‘ P TP — ' © Optional Marker Positions
! Alum. Cap [] i i
i Marked With:
. What to Record
EE- 32 ?’A?’ i * Check off positions
Marker [] Marker [] where markers installed.
Note any offset markers.
Markeri[] * Note pools, streams,
Alum. Cap[] i boulders—anything that
21 23 25 ; vthing
U S may complicate
Marker [] Marker | sampling.

Trimble GPS

Comments:

Initial Establishment Visit
Date Accepted:

Field Crew:

Used:

Plot Nickname:

All GPS Points Attempted? oY/ oN

Plot Delineation Completed? oY /o N

Please be detailed about any GPS points not logged/delineation work still to be done.
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A.8 Tower Plot Log Sheet- 20m by 20m
PLOT MAINTENANCELOG
Domain: Site: Morton Order: Plot ID:
Plot Map: 20m by 20m Tower Base Plot 61 Example
-®
57 i .
A77777777777777777777777777'7'7'7'777777'77'777777777777777776A]- é-"." E N“'i-{?krlf'of.";erzl’-;1
Marker [] ; Marker [ ! i _gg st offset 2.3
| Plot Markers Used
49 50 51 I ¥¢ Primary Markers
O, N i p
Marker [} ° Marker D. ; Marked With:
: i @ standard Secondary Markers
Marked With:
A Additional Secondary Markers
a1 ‘ for Div./Soils Tower Plots
10 * 4¢2 Marked With:
_ Maquel’l:l : 0 Optional Marker Positions
Alum. Cap [] : Marked With:
e | What to Record
Marker [] i i
Alum. Cap[J 3?’7 .~ 73‘3 ~* Check off positions
\ Marker [] 1 where markers installed.
‘S.&Primary marker location (standard plot). ! Note any offset markers.
ASecondary marker location (div./soils plot). 3 « Note pools, streams,
f boulders— hing that
I 55 oulders .anyt ing tha
S A may complicate
: “ap [ERCPri ker location (div./soils plot). o ;
Alam. Cap I rimany ks ctoni el varker [ sampling,
Initial Establishment Visit
Date Accepted: Field Crew:
Trimble GPS Used: All GPS Points Attempted? oY/oN
Plot Nickname: Plot Delineation Completed? oY /o N
Comments:
Please be detailed about any GPS points not logged/delineation work still to be done.
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A.9 Phenology Plot Log Sheet
PLOT MAINTENANCE LOG
Domain: Site: Morton Order: Plot ID:
Plot Map: Phenology Plot
Marker [J ! Marker ] Marker []"}
i Alum-CaplLl plot Markers Used
Y Primary Markers
Marked With:
@ standard Secondary Markers
Marked With:
What to Record
* Check off positions
| : where markers installed.
We o ®E  Forsecondary phenocam
Marker (]| Marker L] transects this will be 3
markers max. Note any
offset markers.

« Note pools, streams,
boulders—anything that
may complicate
sampling.

Viarker i ¢ The Phenocam Plot only
Alum. Cap/[] Marker Marker [ needs markers at the SW,

) e @ ) S, and SE points
SW S SE

Initial Establishment Visit
Date Accepted: Field Crew:
Trimble GPS Used: All GPS Points Attempted? oY/ oN
Plot Nickname: Plot Delineation Completed? oY /oN
Comments:
Please be detailed about any GPS points not logged/delineation work still to be done.
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A.10 Marker Installation Log Sheet

“Permanent” Marker Installation
Date Installed: Field Crew:

Comments (for example, offsets used?):

Maintenance Visit
Date: Field Crew:

Maintenance Issue and Resolution:

Maintenance Visit
Date: Field Crew:

Maintenance Issue and Resolution:

Maintenance Visit
Date: Field Crew:

Maintenance Issue and Resolution:

Maintenance Visit
Date: Field Crew:

Maintenance Issue and Resolution:

Maintenance Visit
Date: Field Crew:

Maintenance Issue and Resolution:

Maintenance Visit
Date: Field Crew:

Maintenance Issue and Resolution:
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APPENDIX B

GPS RECEIVER SETUP

B.1 GeoXH 6000 & Terra Sync version 5.11

Figure 16. GPS receiver Geo XH 6000

1. Turn GPS receiver on by pushing the green power button below the screen. Once the unit is on,
in the screen, look for the Windows start icon ([l] ) in the lower-left side of the screen (Error!
Reference source not found.).

2. |Initialize the Terra Sync software located in the Start menu of the High Resolution GPS unit.
Adjusting GPS Time

On the first day of work at a site, make sure that the GPS unit Time Zone, Date and Time are
appropriate to the location where the measurements will be collected. See instructions below:

Click on the time stamp at the top right of the screen. A pop up bar will appear
underneath.

Click on the clock icon

Adjust the time Zone, Date, and Time

Click on the box for Sync to current time zone

Click OK

4. Setup Menu

Logging Settings

In the upper-left corner at the MDD menu select Setup, tap on Logging Settings:

a. In Accuracy Settings tap on the wrench (£_|) icon and make sure the Accuracy Values For
Display/Logging settings are:

1)
2)

Horizontal
Postprocessed
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3)

4)
5)
6)
7)
8)

Postprocessing Base Distance:

e Obtain this information from RD 20- the NEON Configured Site List.
Base Data: select GPS+GLONASS

Use Accuracy-based Logging: select Yes

Apply Accuracy-based Logging To: Point Features and Vertices
Required Accuracy: 50cm

Tap Done located in the lower left area of the screen

b. Point/Vertex Auto-pause Count: tap on None
c. Antenna Height, tap on the wrench (_{J)and modify the following to:

Antenna Height: 1m

Confirm: Per File

Type: select the appropriate antenna, when setting up the unit for hiking, select the
internal antenna.

Part Number:

Measure Height to: bottom of receiver

Tap Done

Allow Position Update: tap on Confirm
Confirm End Feature: select No

f.  Filename Prefix:

1)

Refer to SOP Error! Reference source not found. (Error! Reference source not found.)
to determine the what the first nine characters of the filenames for the site where you
will be working, which will take the form of D##_SITE_ . Since the first part of the
filename will not change, this may be set this as your prefix to save time in the field.

a) For example, Domain 02 working at SCBI would use the prefix D02_SCBI_ .

Optional: Placeholder text can be used to indicate the required file name format (see
SOP Error! Reference source not found.). Items beyond the four-letter site code can
then be replaced with plot-specific text in the field.

a) For example: D02_SCBI_Morton#_plotType_GPS_Vi .

g. Waypoint Filename Prefix: W

h. Between Feature Logging:

1)
2)

Style: Time
Interval: off

i. Tap Done at the bottom left side of the screen.

GNSS Settings

Tap on GNSS Settings:
a. GNSS Receiver Port: COM3
b. Check on the box for Use Smart Settings
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c. NMEA Output: OFF

d. Tap Done located in the lower left area of the screen
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Real-time Settings

Tap on Real-time Settings:
a. Choice 1: tap on Use Uncorrected GNSS
b. Tap Done

Coordinate System

Tap on Coordinate System:
Select the coordinate system used for all shapefiles and imagery uploaded to the unit for a
specific site.
a) System: obtain this information from (RD [20])- the NEON Configured Site List
b) Zone: obtain this information from (RD [20])- the NEON Configured Site List
c) Datum: obtain this information from (RD [20])- the NEON Configured Site List
d) Altitude Reference: Mean Sea Level (MSL)
e) Altitude Units: Meters
f) Display USNG: OFF
g) Coordinate Units: Meters
h) Coordinate order: East/North
i) Click Done located in the lower left area of the screen

Tap on Units:

Distance Units: Meters

Area Units: Square Meters

Velocity Units: Kilometers per hour
Angle Units: Degrees

Lat/Long Format: DD.ddd’

Offset Format: Horizontal/Vertical
North Reference: Magnetic Declination

Sm 0 a0 oo

Magnetic Declination: Make sure that the declination is set on auto.

e Declination changes with time and space; as long as the GPS is in auto, it will update it
automatically. Positive declination values are East, negative values are West. To verify
the correct auto declination is set, obtain the current declination values for your
location from http://www.ngdc.noaa.gov/geomag-web/#declination .

External Sensors

5. Tap on External Sensors: uncheck all sensor check boxes. This concludes GPS settings. Unit can
be shut down or brought to standby mode.
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APPENDIXC  CRITERIA FOR PLOT ESTABLISHMENT IN WET LOCATIONS

Does the vegetation community
contain > 50% local hydric plant
species?

Ask the staff botanist

T

Yes No

Determine whether or not standing
water will be present year-to-year
(i.e., is this just a wet year?)

T

Yes No

Is > 50% of the plot area covered by
standing water > 30 cm in depth?

g2t g

Yes No
Reject Continue to plot Continue with plot
Plot establishment establishment
location and issue JIRA
ticket regarding
acceptable
protocols
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APPENDIXD  PLOT ESTABLISHMENT WORKFLOWS

D.1 Overall field steps

Compile all Equipment and Materials sorA

!

Navigate to preloaded point sor B <

Complete NLCD canopy cover assessment
Does the vegetation at the plot match the expected
vegetation class? sopB Complete logistical validation.

NO YES

Create a New Data File Create a New Data File
Reject plot location, note the reason, Record metadata in data dictionary

choose next plot from RRQRR list. sopP B SCI’B |
Is the plot a tower or distributed plot?
Distributed é
Tower
v |

Perform Distributed plot Delineation
and Monumentation for :

Base, Small Mammals, Birds or Ticks. Perform Tower plot D'elmeatlon
SoPC and Monumentation for :

Plant Productivity or Phenology.
sopPc

Conduct GPS Coordinate Collection.
SOPD

Check for co-located plots. Pull flagsand
tape, navigate to next preloaded
potential plot origin.
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D.2 Tower Plot Workflow

Type: Tower Subtype:
Base Plot

Locate Centroid

Complete validation and fill out metadata

v
Mark Centroid
Forest vegetation plot Grassland/agricultural vegetation
Delineate a 40 X 40 m plot Delineate a 20 X 20 m plot
= -
SE 50 L6l
49 [ a] 51 75
L 39 WA R . il . =
| :
1 H H
20m
i 41
- - L 312 : 33 [(5)
X 23 25 % S 6 =

% Primary Marker label PlotID (e.g. CPER_001) and PointID (e.g. 41)
® Secondary Marker label all markers with corresponding PointID numbers, see

above (e.g. 57)

= Photos taken towards plot centroid

M\

Collect high resolution GPS
coordinates for all points
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Tower Plot, Subset that includes Soil and Plant Diversity Sampling

Type: Tower

Subtype: Base Plot

Only for a subset of tower plots that will measure: Biogeochemistry, Microbe, and Plant
Diversity. See the XX_XXXX_TOS_Plot_Datasheet column “subtype Specification”

Locate Centroid

Complete validation and fill out metadata

Mark Centroid

Forest vegetation plot

Grassland/agricultural vegetation

Delineate a 40 X 40 m tower plot

And
20 x 20 m plot
573 2 o &1
49 51
. 4
39 | a0 IR
: |
' 20m
£ 31 133
[ @
21F 25
« 2 ]

Delineate a 20 X 20 m plot
And
40 x 40 m corners

% Primary Marker label PlotID (e.g. CPER_001) and PointID (e.g. 41)
® Secondary Marker label all markers with corresponding PointID numbers, see

above (e.g. 57)

== Photos taken towards plot centroid

Collect high resolution GPS
coordinates for all points
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D.4 Tower, Primary Phenology Plot Workflow

Type: Tower
Subtype: Phenology Plot

Use preloaded data to locate and mark
all points

Fill out metadata

Final plot is
200 x 200 m

100m

* Primary Marker label PlotID (e.g. CPER_001) and PointID (SW, NE)
® Secondary Marker label all markers with corresponding PointID cardinal

__ directions, see above (e.g. NW)
Take photos towards next point on transect in a clockwise direction

!

Collect High resolution GPS
coordinates for all points
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D.5 Tower, Secondary Phenology Plot Workflow

Type: Tower

Subtype: Phenology Plot
Secondary Plot if applicable

Use preloaded data to locate and
mark all points

Fill out metadata

Final transect is

200 m

SE

100m

* Primary Marker label PlotID (e.g. CPER_001) and PointID (SW)
® Secondary Marker label all markers with corresponding PointID cardinal
directions, see above (e.g. S)
Take photos towards next point on transect in clockwise direction.

Collect GPS coordinates for all points
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D.6 Distributed, Distributed Base Plot Workflow

Type: Distributed
Subtype: Base Plot

Locate Centroid

Complete validation and fill out metadata

Mark Centroid

Delineate Plot
Inner plot 20 x 20 m
Outer plot 40 x 40 m

57
@ L
49 5] o]
o = e 51 3
41
I I
p— 20m
10m
31 33
*-
21
@ @

61

25

Y Primary Marker label PlotID (e.g. CPER_001) and PointID (e.g. 41)
® Secondary Marker label all markers with corresponding PointID numbers, see above

. (e.g.57)

Photos taken towards the centroid

J

Collect GPS coordinates for all points
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D.7 Distributed, Tick Plot Workflow

% Primary Marker label PlotID (e.g. CPER_001) and PointID (41, 21)
® Secondary Marker label all markers with corresponding PointID numbers, see

Type: Distributed
Ticks

Locate Centroid

Complete validation

and fill out metadata

Delineate Plot

40x40m
57
[ 2 e
41
*
|
20m
21
o

above (e.g. 57)

|

61

25

Collect GPS coordinates for all corner points
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D.8 Distributed, Small Mammal Grid Workflow

Type: Distributed
Subtype: Mammal Grid

Locate Centroid and 4
Corners

I Fill out metadata |

|

| Mark Centroid and4 Corners l

I

| Collect Centroid I

% Primary Marker label PlotiD (e.g. CPER_001) and PointID (ES)

@ Secondary Marker label PointID (e.g. A1)

!

Set up

100 x 100 m
(no GPS pointsrequired besidesES, follow
instructionsin small mammal protocol)

'Q NEON Mammal Grid
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D.9 Distributed, Bird Grid Workflow

Type: Distributed
Subtype: Breeding Birds

Locate Centroid

Mark Centroid

Collect high
resolution GPS
coordinates for

centroid

% Primary Marker label PlotID (e.g. CPER_001) and PointID (B2)

B2

Final grid
500 x 500 m

{no GPS pointsrequired
besidescentroid)
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D.10

Distributed, Mosquito Point Workflow

Type: Distributed
Module: Mosquitoes

I Locate Point |

Shift point up to 10m if

needed (point needs to

be >5m from road)

Validate the vegetation and fill
out data dictionary

J

| Mark the point |

*

* Primary Marker label PlotiD (e.g. CPER_001)

Collect high
resolution GPS
coordinates for

point
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APPENDIXE  NLCD VEGETATION CLASSIFICATION DESCRIPTION

Class/Value

Classification Description

Water areas of open water or permanent ice/snow cover.
12|Perennial Ice/Snow - areas characterized by a perennial cover of ice and/or snow, generally greater
than 25% of total cover.
Developed areas characterized by a high percentage (30% or greater) of constructed materials (e.g. asphalt,

concrete, buildings, etc.).

Developed, Open Space - areas with a mixture of some constructed materials, but mostly vegetation
in the form of lawn grasses. Impervious surfaces account for less than 20% of total cover. These areas
most commonly include large-lot single-family housing units, parks, golf courses, and vegetation

planted in developed settings for recreation, erosion control, or aesthetic purposes.

Developed, Low Intensity - areas with a mixture of constructed materials and vegetation. Impervious
surfaces account for 20% to 49% percent of total cover. These areas most commonly include single-

family housing units.

Barren

areas characterized by bare rock, gravel, sand, silt, clay, or other earthen material, with little or no

"green" vegetation present regardless of its inherent ability to support life. Vegetation, if present, is
more widely spaced and scrubby than that in the green vegetated categories; lichen cover may be
extensive.

Barren Land (Rock/Sand/Clay) - areas of bedrock, desert pavement, scarps, talus, slides, volcanic
material, glacial debris, sand dunes, strip mines, gravel pits and other accumulations of earthen
material. Generally, vegetation accounts for less than 15% of total cover.

Forest

areas characterized by tree cover (natural or semi-natural woody vegetation, generally greater than 5
meters tall); tree canopy accounts for 20% to 100% of the cover.

Deciduous Forest - areas dominated by trees generally greater than 5 meters tall, and greater than
20% of total vegetation cover. More than 75% of the tree species shed foliage simultaneously in

response to seasonal change.

43

Mixed Forest - areas dominated by trees generally greater than 5 meters tall, and greater than 20%
of total vegetation cover. Neither deciduous nor evergreen species are greater than 75% of total tree

cover.
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areas characterized by natural or semi-natural woody vegetation with aerial stems, generally less

than 5 meters tall, with individuals or clumps not touching to interlocking. Both evergreen and
deciduous species of true shrubs, young trees, and trees or shrubs that are small or stunted because
of environmental conditions are included..

52

Shrub/Scrub - areas dominated by shrubs; less than 5 meters tall with shrub canopy typically greater
than 20% of total vegetation. This class includes true shrubs, young trees in an early successional
stage or trees stunted from environmental conditions.

Herbaceous

areas characterized by natural or semi-natural herbaceous vegetation; herbaceous vegetation
accounts for 75% to 100% of the cover.

71

Grassland/Herbaceous - areas dominated by gramanoid or herbaceous vegetation, generally greater
than 80% of total vegetation. These areas are not subject to intensive management such as tilling,
but can be utilized for grazing.

Planted/Cultivated

72

Sedge/Herbaceous - Alaska only areas dominated by sedges and forbs, generally greater than 80% of
total vegetation. This type can occur with significant other grasses or other grass like plants, and

includes sedge tundra, and sedge tussock tundra.

areas characterized by herbaceous vegetation that has been planted or is intensively managed for the
production of food, feed, or fiber; or is maintained in developed settings for specific purposes.
Herbaceous vegetation accounts for 75% to 100% of the cover.

Wetlands

81

Pasture/Hay — areas of grasses, legumes, or grass-legume mixtures planted for livestock grazing or
the production of seed or hay crops, typically on a perennial cycle. Pasture/hay vegetation accounts
for greater than 20% of total vegetation.

areas where the soil or substrate is periodically saturated with or covered with water as defined by
Cowardin et al., (1979).

90

Woody Wetlands - areas where forest or shrubland vegetation accounts for greater than 20% of

vegetative cover and the soil or substrate is periodically saturated with or covered with water.
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APPENDIXF  PLOT DELINEATION LAYOUT

Use the following schematics in the field to keep track of your progress, place diagram in page protector,
and mark off points with a dry erase as you locate them. Rounded corners indicate where tape is

wrapped.
F.1 Tower Plot — 40x40 meters
NW 315° N 3607
e * °
57 58 59 60 61
48
W270° o
39
30
———————————————————— 40m ------~-~-"-J--~-~-~-—-~-—-———-- -
21 22 23 24 25
O ® ®
7 2250
SW 223 S 180°
Tape only

e Rangefinder/Compass + Tape

O Primary plot marker
) Secondary plot marker
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NE 045°

F.2 Tower Plot — 20x20 meters
NW 315° N 360°
rz;g\ 50 51
~1414m | om
W 270° A
40 / a1 42
Centroid
e o 20m
31 32 334
SW 225° S 180°

o

Rangefinder/Compass + Tape

Primary plot marker

Secondary plot marker
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APPENDIXG  SCHEMATIC OF COMPLETE GRID USED TO LABEL PLOT POINTS

73 74 75 76 77 78 79 80 81

64 65 66 67 68 69 70 71 72

55 56 57 58 59 60 61 62 63

46 |47 |48 |49 1so |51 [s2 |53 |s4 Plot Centroid

10mx10m
37 38 39 0 A4 a2 43 44 45

20 m x 20 m plot

28 29 30 31 32 33 34 35 36 40 m x 40 m plot

80 m x 80 m plot

OOoofdfo

19 20 21 22 23 24 25 26 27

10 11 12 13 14 15 16 17 18

75 2 3 4 5 6 7 8 9

Figure 17. Schematic of the point ID grid
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APPENDIXH TROUBLESHOOTING

H.1

GPS

The unit shuts down on its own:

o Click on the Power button once to check if it is on standby mode. If it were on standby it

should turn on once

o Restart the unit by pressing on the Power button and check the battery, if the battery is low,

o Replace the battery with a fully charged extra battery

TerraSync map display is incorrect:

o Tap with the stylus on MDD>Setup, then tap on coordinate system and make sure the
coordinate system, zone, and datum are correct.

o If the map doesn’t display correctly check the .imp file coordinate system by locating
the .txt file located in the shared folder where the .imp file is locate on the computer.

o Click on the .txt files in the corresponding folder and find the one that displays the .imp file
in use and check the output data coordinate system, zone and datum. If the coordinate
system is incorrect, the file will have to be imported again into Pathfinder with the corrected

coordinate system.

Accidentally clicked on the camera button:
o Click OK to the bottom right of the screen.
o Click on the ‘X’ symbol to the bottom right of the screen, the next screen should be the

TerraSync working screen
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H.2

Plot Establishment Obstructions
Large trees, rocks or over/below brush

If there are obstructions (i.e. large tree, rocks...) between Person 1 & Person 2 when using the
rangefinder to place a marker or make measurements:

o Use the Rangefinder 360R in HD mode to accurately measure 10m of horizontal distance
along the slope. Depending on the degree of slope, using the transect tape could result in
moving the flag to 10.5 m instead of 10 m. If this is performed along the center line, this
adjustment should be propagated through the remaining points on that line (i.e. 20.5, 30.5
etc.). Using the Rangefinder in filter mode and shooting at a reflector can help determine
where exactly to place the flag.

o Both people can step to the side up to 3 times away from the point or use an alternative
standardized measurement to get a clear reading. Once a clear reading is acquired move
back to the original point and place marker.

Perzon 1

Parson 2 ..( ........... .

Obstruction

~ Lineof sight i .

— L

o<

Figure 18. Alternative strategy when obstructions are in line of sight during plot delineation

o If low/high stature obstructions are encountered between Person 1 & person 2 when using
the tape, pull the tape up/down on both ends and measure above/below the obstruction;
make sure to use the rangefinder to verify results.
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49

40

31

Plot verification obstructions

O

When looking for a line of sight for verification, if the initial suggested diagonal line of sight
is obstructed, use the Pythagorean Theorem c? = b? + a2 to find the unobstructed
hypotenuse of a right triangle within the plot to complete the verification (Error! Reference s
ource not found.4). For example, if there is a line of obstruction for verification of point 49
from point 41 when delineating a 20 by 20 meter plot, there are several hypotenuse options
(Error! Reference source not found.4a) select the one that is clear of obstructions and use it t
o verify point 49 (Error! Reference source not found.4b). Calculate the hypotenuse distance
with the base and the height of the right triangle; in this case using the right triangle

between points 49, 31 and 32 (Error! Reference source not found.b) the hypotenuse “c
would be:

2=p? + 32
c=v(20% + 10?)

¢ =V(500)
c=22.36 meters

In order to verify point 49 from point 32 the distance measured with both the tape and the
range finder should be 22.36 meters.

b. 10m
50 51 49 50 51
c=v {b2 + az}
20
41 42 40Q 41 42 ' m
b
3 33 31 3 33

a
Figure 19. Hypotenuse option to verify plot delineation measurements
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APPENDIX I

PLOT MONUMENT INSTALLATION JSA

DESCRIPTION OF JOB TASK: As required in the TOS Protocol and Procedure for Plot Establishment, up
to two permanent monuments will be installed at all distributed and tower plots where the site host
has approved such monumentation. The permanent markers generally consist of one or more sections
of aluminum rods, a top cap stamped with information related to the point and plot, and a bottom
spike to facilitate driving the rod into the ground.

Marker segments.

Item JOB STEP SEQUENCE POTENTIAL RECOMMENDED SAFE
HAZARDS PRACTICE

1 Travel to jobsite. Improper use Before the work starts, the
Before work begins, or failure of crew must be aware of the
review steps of this equipment can | potential hazards associated
procedure with cause serious with the task. The team must
workers. Inspect injury or also be aware of the intended
worksite for hazards. property safe procedures and the

damage. appropriate PPE to be worn

Driving, during the operation. Journey

Bees/Wasps, Management and Vehicle

Ice, Trips, etc. safety best practices should be
followed.

2 Inspect and put on Failure to Personnel should inspect PPE
personal protective identify worn before use. It is the end user’s
equipment. PPE. Improper responsibility to ensure PPE is

use of PPE. in functional condition before
beginning work.

3 Remove old temporary | Strain on back. | Use crowbar to gain leverage
markers. to reduce strain on back.

4 Build Permanent Segments could Use pliers or a wrench with

loosen, causing
marker to
bend, leading
to a missed
blow with the
T-post driver.

teeth to tighten each segment
and driving adapter before
being to pound marker with T-
post driver.
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Drive Permanent
Marker into the
ground.

Loud noise,
blisters on
hand, crushing
of hands, strain
on back.

Ear protection must be worn by
both people on the plot. Thick,
impact gloves must be worn by
the person using the T-post
driver. DO NOT lift the T-post
driver above the scored
marking line on the top section
of the Permanent Marker while
using the T-post driver. The
second person on the plot
should be watching the person
using the T-post driver to
ensure this does not happen.
After every 6-12 blows with the
T-post driver, check the
connections of the marker
segments and the driving
adapter segments and the
driving stud.

Attach additional
Permanent Marker
segments until needed
depth is reached.

Strain on back.

Do not continue to operate the
T-post driver once the
Permanent Marker has reached
an uncomfortable position.
Attach a new segment of
marker to reduce back strain.

Permanent Marker
may need to be cut, if
bedrock or difficult soil
substrate is
encountered. A battery
powered reciprocating
saw or hacksaw are the
appropriate tools for
this.

Cutting off
finger, loud
noise, hot
metal shards in
eyes or on
hands.

Both people on the plot must
wear safety glasses, gloves and
hearing protection. When
assembling the hand or power
saw, be sure to have parts
secured before beginning to
cut the Permanent Marker. The
second person on site should
verify this before cutting
begins. If both people are not
comfortable using the sawzall
then a hacksaw will be used
instead.

Install Marker Cap

Strain on back,

crushing hands.

Once the Permanent Marker
has reached needed depth,
remove excess segments
installed to reduce back strain.
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Then install Marker Cap with a
plastic sledge hammer

APPENDIX J BASE STATION WORKFLOW

Establishing a base station increases accuracy by providing more accurate data for post-processing. With
data originating closer (directly on) to a site, post processing of GPS data from field technicians is more
effective at reducing noise and eliminating interference which results in far greater accuracy in our GPS
data collection efforts. This gain in accuracy is often enough to see rejection rates reduced three fold.

Setting up a new monument is a straightforward process that must be done in proper order to ensure
good returns on all future GPS data collection. Setting up a new monument includes one 5+ hour day in
the field and at least 1 hour of internet connected computer post processing. Monumentation only
needs be done once and can be done days (or weeks) prior to a GPS measurement bout. Once the
monument is established, daily GPS collection bouts will follow the plot establishment protocol SOP D
with the addition of setting up the base station coverage in the morning, taking it down at the end of
the day, and transferring the base station data along with GPS files to Science.

Overall the workflow of using a base station is exactly the same whether establishing a new monument
from scratch or setting up over an established monument in preparation for collecting GPS data during
plot establishment. Because of this, the directions of each step in the workflow have been written out
into a single list of steps, with any workflow specific deviations noted.

Summary Workflow:

1) Monument setup (this is done just once per site):

a. Set up new monument site.
Collect base station data for at least 5+ hours (NO plot establishment measurement).
Stop collection of data.
Transfer data to handheld in field.
Break down base station setup.
Transfer data to computer.
Process data with OPUS.

i. Need an internet connection to complete this step.

™ 0 o0 T

2) Base station coverage:
a. Setupon the established monument.
b. Run base station coverage, starting survey.
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Collect GPS data for TOS plots following SOP D.
Finish running base station coverage, ending survey.

Transfer data to handheld in field.
Break down base station setup.
Transfer data to computer.

Send both base station and Trimble data to science staff for post processing.

Detailed Instructions

The following equipment is needed to implement the procedures in this document. The list below only

includes equipment needed to monument and the run the base station. Reference the equipment list in

section 6 for supplies need to complete plot establishment.

Table 7. Base station equipment list

It £ s
£ om—
em R/S Description Purpose = o 7
No. = Q.
g | i
Rented- Portable GPS base
. . station to facilitate cleaner
R Trimble R10 GNSS Receiver ) . . . 1 N
differential correction during
post processing
Quick release, Tribrach, Lever Rented- Connects the R10 GNSS
R . . . 1 N
Extension Receiver to the Tripod
R Trimble TSC3 Data Collector and Rented- Hand held data 1 N
Charger recorder
R Tripod, 2m Poles Ren.t(.ed— Holds the R10in a level 1 N
position
R R10 Battery Charger Rented 1 N
R R10 Batteries Rented- Includes one back up ) N
battery
. Up to 5m, measure the height of
R Measuring Tape the R10 1 N
R Stakes Mark the monument location 1 N

R/S=Required/Suggested
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A. Set up monument at site

a. Choose ideal location:

e Clear, open with as large an unobstructed horizon as possible. The base station
is only a good as its ability to get solid, clean data from GPS satellites. First
choice should be an open field with no large trees blocking horizon. If not
available, prioritize open canopy/lack of canopy cover.

e Safe, secure location where base station can be left for 5+ hours. If possible,
place nearby to any tower construction happening during plot establishment.

e Easy to access. Every plot establishment day will begin with setting up the base
station and end with taking it down. Additionally, it may be necessary to change
batteries mid-day, therefore having easy access is paramount to completing
multiple plots in a single day.

o |f a site does not appear to have a good monumenting location, work with
Science to determine where one should be placed or if, possibly, multiple
monuments may be necessary. Multiple monuments may be required in
particularly large sites where travel logistics change halfway through plot
establishment (travel times, road access issues, etc.).

b. Place a marker in the ground to identify the monument. This should either be a large
orange plastic stake or a metal marker stake. It is imperative that this marker be secure
and not movable during the duration of plot establishment.

e The base station must be placed in exactly the same location every time in order
to generate reliable data.

o |f possible leave a permanent marker in for any future GPS collection efforts.

1. If permanent markers are not allowed at the site use a temporary
marker during plot establishment

c. Photograph marker location.

B. Set up the tripod

a. Set up the legs looking for cracks/soil to help stabilize the unit.

b. Extend the legs so that the top of the tripod should be about chin height.

c. Make sure the tripod is as level as possible before attaching the tri-bracket.

d. Attach the tri-bracket.

e. Use the eyepiece to make sure the unit is squarely over a marker you placed in the
ground. If you cannot find the marker in the eyepiece, wiggle your foot around
underneath the tripod to try to locate where the eyepiece is seeing.
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f.  Finish leveling the legs. Shift between leveling, making sure the eyepiece is aiming at the
marker, and using the leveling screws on the tri-bracket. Remember that the “ring” on
the leveling screws is the halfway mark if you need to reset the screws.

g. Attach the trimble base station, quick connecter (grey), and quick mount first as one
unit (Shown below in order, left to right. The tri-bracket is the part on the right)

BRBLN

SO BT R RGN

Figure 20. Base station equipment

h. Attach the base station unit to the tri-bracket.
i. Tighten all connections.
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Figure 21. Base station setup.

j. Turn on the base station unit.

C. Run base station coverage
a. Turnon the handheld unit.
b. Create a new job.
i. The naming convention is to name the job the date of that day’s work. The
format is SITE_MMDDYY.
ii. Set up the coordinate system.
1. Use the selection library to choose the correct UTM system.
2. We are using a gridProject height- should be ~100m of the average
height of the site

a. For the initial collection of base station data: This information
will be provided by Science.

b. For subsequent days after the base station data has been
processed: Use the output from the OPUS solution (see below
for more information about OPUS).

3. Store the coordinate information.
iii. No active map, line, etc needed.

rimmoie-

Figure 22. Setting up a new job

iv. If prompted, set log rate to 1 log per second.
v. Press accept- the job is created.
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1. Once you set up one job the template can be re-used for additional jobs
and will require no changes.
c. Start the survey
i. Go to “Instrument” button.
ii. Go to “GNSS function”.
1. The handheld should connect automatically with the base station
through blue tooth.
a. If difficultly connecting to the base station:

i. Hit the config button.

ii. Scroll down the list, tap and hold on the base station’s
name (serial number), delete the connection, then
repair it.

iii. If a screen comes up that says “Passcode” hit next, no
passcode is needed.

iii. If you are correctly connected to the base station the “base mode” button
should be orange (this sometimes only appears after logging has started).

Figure 23. Base mode highlighted orange

1. Another check: On the main screen there will be some information
about the base station and battery life
a. Top battery is for the handheld receiver
b. Bottom battery is for the base station
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Figure 24. Battery status display

iv. Insurvey styles select “logging”.
1. Keyin point name: Monument_1.

Figure 25. Entering site specific information

2. Code: BM (for benchmark).
3. It will ask you for a location.

a. Forthe initial collection of base station data: press the “here”
button to generate a location based on the base station’s
current readings from GPS satellites.

i. Note: this a VERY rough approximation of location and
is only there as a placeholder until OPUS can return the
real solution.
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b. For subsequent days after the base station data has been

processed: enter in the easting and northing provided by the
OPUS email.

Figure 26. Entering the spatial information

4. Antenna height:
a. Measure from the ground to the lever arm extension on the
base station unit using the measuring tape.
i. The lever arm extension is the black handle on the
bottom of the black bar before the tri-bracket.

b. Use the “units” dropdown menu on the side to select meters.
Hit start.
If the base station’s down arrow is lit up it means it is storing data.
Power down the handheld (green button).

d. End the survey

For the initial collection of base station data: Make sure the base station has
run for at least 5 hours.
Verify the base station unit is still powered on.
Power on the handheld.
In the GNSS window select “end survey” .

1. Do not turn off base station, you will need to transfer files first.
NOTE: if the base station runs out of battery before ending the survey, DO NOT
MOVE IT. Power it back up and end survey before moving. When it powers back
on the unit will continue to log points. It is better to leave the tripod overnight
(taking the base station unit with you) and giving it a fresh battery in the
morning than trying to take the station back and powering it up elsewhere.
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D. Transfer data
These first steps should be done in the field as soon as the survey is ended.

a. Connect the handheld receiver (in practice it should still be connected) to the base
station (using the instrument button and steps described in the handheld receiver
setup).

b. Import files.

i. Choose the files you want to import.
ii. Imports can take some time if the file is large (5-10minutes).

c. Turn off the base station unit.

The following steps can be done back at domain HQ.

d. Use either a flash drive or connect the handheld receiver to the computer to transfer
files over.
i. Files will be saved in the handheld in folders labeled by each job title. These
folders are created when each job is created.
ii. If using a flash drive:

1. Sometimes takes a minute to register the “harddisc” on the handheld
receiver.

2. Highlight the files you want to transfer, go to the menu>edit>copy.

3. Paste into the open space in the harddisc screen.

iii. If using the cable:

1. Connect handheld to computer in same method as a regular trimble
handheld.

2. Once connected properly, find the device in “my computer”. It will act
exactly like an external hard drive. No software needed (e.g. pathfinder
office).

3. Find the files you wish to transfer and just click and drag into
“basestation” folder. This “basestation” folder should be located in the
same place that standard .ssf trimble files are exported to.

e. Email the Science staff you are working with that all files are transferred.

E. Post processing the data.
This work can either be done by TOS spatial techs or, in the interest of speed, by FOPS
technicians. All software is freely available and requires no special licenses. However, it is
somewhat technical and can be overwhelming to those less familiar with the process. Work with
your team lead or TOS spatial technician to determine who best to process this data. When
setting up a new monument, the base station data will need to be converted to RINEX and then
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processed with OPUS. When using the base station for differential correction of plot spatial
data, the base station data need only be converted to RINEX. The executable for converting
trimble data to the RINEX format can be found at this website, hosted by Trimble:
http://www.trimble.com/support_trl.aspx?Nav=Collection-40773&pt=Trimble%20RINEX

a. Convert to RINEX.
i. Transfer base station GPS files to “basestation” folder in GPS_pathfinder_data

area of FOPS GIS folder tree.
ii. Using Trimble executable, “Convert to RINEX”, open GPS files. They will have a

.TO2 extension.
1. Note: this software will often appear greyed out when first opening,

don’t be thrown off by the appearance.

(S| S

File | Tools Help

Open... Ctrl+0

Convert Files

Exit

Figure 27. RINEX Conversion

iii. Once opened, you can check the metadata regarding the collected base station
GPS information. To convert to RINEX, go to “File” and select “Convert Files”.
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File Tools Help

E 0 File Settings.
Input

=- ANTOS\TOS_Workspace\17_Paciic
- 29022790.T02

Input fie type

RINEX file extension
RINEXfile niame w/o exention
RINEX file path

RINEX file version

RINEX MET/AUXfile generation rule
B 1 Rinex Header Settings - Requi

AATOSNTOS_Workspacsh17_PachicSW\REL2_SOAP\Spatial_|
t01File
YYO. YYN. YYM

29022790
AATOS\TOS_Workspace\17_PacificSW\REL2_SOAP|
RINEX Version 302

Create if present in input

Agence Trmble
Observer name GNSS Observer
Program run by convert TORINEX OPR
B 2 Rinex Header Settings
Marker approxmate X, meters 2492293 3979
Marker approdmate Y. meters 4448109 6601
Marker approdmate Z, meters 3820995 7427
Marker name wednesday
Marker number
Marker type {v3.02 only) GEODETIC
E] 3 Antenna Settings
Antenna header name TRMR10 NONE
Antenna measurement point Measure to ARP
Antenna offset, meters 147
Antenna serial number
Antennatype R10 Intemal
E] 4 Recsiver Settings
Recsiver header name. R10
Recsiver serial number 5506492902
Recsiver type R10
Receiver version 500 -
Agence ]
« v I
Complete! |

Figure 28. RINEX metadata

b. OPUS post processing

i. Go tothe OPUS website: https://www.ngs.noaa.gov/OPUS/
1. Send the “.0” file created in the RINEX conversion to OPUS.
2. Inthe OPUS drop downs:

a.
b.

Select the antenna type.

Copy antenna height from the Rinex file summary. This is

“Antenna.offset.meters” in section 3 (the height will

automatically be calculated from the antenna height even

though we measured the lever height in the field).

3. In options, selected “format standard and xml” for easier viewing.

4. To begin process click “Upload to Static”.

c. Read the OPUS report to get monument location.
i. Towards the bottom of the email, look for “UTM COORDINATES” (will be next to
state plane coordinates).
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1. Try copy/pasting into notepad for easier reading.
ii. Record Northing and Easting for use when starting surveys.

Cc
Subject: OPUS solution : 29022520 160 OF1473451375737
] Message | | |2902252g.160.xml (4 KB)
SOFTWARE: pages 1209.04 masters.pllbU3dl  STARI 2016/U5/08 16:03:00
EPHEMERIS: igr19134.eph [rapid] STOP: 2016/09/08 21:37:00
NAV FILE: brdc2520.16n OBS USED: 3099 /11184 : 28%
ANT NAME: TRMR10 MNONE #FIXEDAMB: 70/ 96 : 73%
ARP HEIGHT:1.26 OVERALL RMS: 0.024(m)

REF FRAME: NAD_83(2011)(EPOCH:2010.0000) IGS08 (EPOCH:2016.6879)

X -2492291.044(m) 0.200(m}  -2492291.847(m) 0.200{m)
¥: -4448109.826(m) 0.102(m)  -4448108.476(m) 0.102{m)
Z:  3820994.594(m) 0.046(m) 3820994.546(m) 0.046(m)

LAT: 37 157.65549 0.023(m) 37 157.66863 0.023(m)

ELON: 24044 16.59124 0.224[m)  2404416.53268 0.224{m)

WLON: 1191543.40876 0.224(m) 1191543.46732 0.224{m)

ELHGT:  1171.257(m) 0.065(m) 1170.640(m) 0.065{m)
ORTHOHGT:  1199.456(m) 0.113(m) [NAVDSS (Computed using GEOID12B)]

UTM COORDINATES STATE PLANE COORDINATES
UTM (Zone 11} SPC (0404 CA 4)
Northing (Y) [meters] 4100890.643 688596.932
Easting (X) [meters]  298802.668 1976684.592
Convergence [degrees] -1.36282778 -0.15634043
Point Scale 1.00009870 0.99996550
Combined Factor 0.99991491 0.99978213

US NATIONAL GRID DESIGNATOR: 115KB9880200890{NAD 83)

BASE STATIONS USED
PID  DESIGNATION LATITUDE LONGITUDE DISTANCE({m)
AH2502 MINS MINARET SUMMIT CORS ARP N373913.535 W1190339.187 71237.2
DK6290 MUSE MUSICK MOUNTAIN CORS ARP N2371011.774 W1191833.611 15829.6
DN7369 P307 MADERADOT_CN2005 CORS ARP  N365650.159 W1200328.459 71495.5

NEAREST NGS PUBLISHED CONTROL POINT
HR2778 BALD MOUNTAIN LOH N370611.995 W1191222.401 9280.8

Figure 29. OPUS Report
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